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บทที่ 2 

เอกสารและงานวิจัยทีเ่ก่ียวข้อง 
ในการศึกษาวิจัยเรื่องการการสร้างแบบลวดลายแกะสลักไม้  ด้วยคอมพิวเตอร์เพ่ือใช้ในการ

สร้างผลิตภัณฑ์ไม้แกะสลัก ผู้วิจัยได้ศึกษากระบวนการออกแบบลวดลายการแกะสลักไม้ด้วยการใช้
โปรแกรมคอมพิวเตอร์สําเร็จรูปซ่ึงสามารถสร้างรูปแบบและลวดลายต่าง ๆ ให้เกิดประโยชน์เป็นใน
การนําลวดลายมาประยุกต์ใช้ในการสร้างเป็นผลิตภัณฑ์งานไม้แกะสลัก  การสร้างแบบเพ่ือใช้ในการ
แกะสลักมีความจําเป็นอย่างย่ิงในการแกะสลักไม้เพราะการได้มาซ่ึงช้ินงานที่สวยงาม  ย่อมเกิดจาก
การที่ได้สร้างแบบลวดลายไว้อย่างดี  ได้สัดส่วนท่ีถูกต้องลงตัวการแกะสลักไม้มีความจําเป็นอย่างยิ่งที่
จําต้องมีรูปแบบหรือลวดลายท่ีออกแบบมา  เพ่ืองานแกะสลักโดยเฉพาะเราจะนําเอาลวดลายสําหรับ
งานเขียนมา  ใช้เป็นแบบแกะสลักไม่ได้เน่ืองจากเหตุผลหลายประการท่ีได้กล่าวในข้างต้นไว้แล้วเช่น 
เรื่องของช่องไฟ  การวางหน้าสิ่วให้พอดีกับลวดลายท่ีจะทําการแกะสลัก ฯลฯ  

ในปัจุบันเทคโนโลยีด้านคอมพิวเตอร์ได้มีความเจริญก้าวหน้า  อย่างรวดเร็วและเข้ามามี
บทบาทในด้านงานต่าง ๆ อันเน่ืองมาจากคอมพิวเตอร์ทําให้การดําเนินงานต่าง ๆ เป็นไปอย่าง
สะดวกสบาย มีคุณภาพและปริมาณงานสูง  การนําคอมพิวเตอร์มาใช้งานด้านต่าง ๆ เช่น งานด้าน
ธุรกิจ  อุตสาหกรรม  การแพทย์ การบริการ หรือทางด้านงานศิลปะและการออกแบบ จึงเป็นไปอย่าง
แพร่หลายรวมถึงด้านการศึกษา ซ่ึงนักการศึกษาได้มีการพัฒนาการระบบคอมพิวเตอร์เพ่ือใช้ใน
กิจกรรมการศึกษาด้านต่างๆ เช่นด้านการบริหารศึกษา ComputferFor EductaionAdministraion) 
ด้านบริการการศึกษา( Computer Education Service)   

ผู้วิจัยเล็งเห็นว่าการเรียนการพัฒนาทางด้านงานออกแบบหรือทางด้านศิลปะ  มีความจําเป็นที่
ต้องใช้คอมพิวเตอร์   เพ่ือให้ทันต่อความเจริญก้าวหน้าทางด้านเทคโนโลยี  การใช้คอมพิวเตอร์
สามารถนํามาใช้ในการออกแบบและเขียนแบบลวดลายแกะสลักได้เป็นอย่างดี  อีกท้ังยังสร้างเป็น
ฐานข้อมูลและรวบรวมรูปแบบและชนิดของลวดลายแกะสลัก  อีกท้ังยังสามารถแก้ปัญหาเกี่ยวกับ
เน้ือหาหรือลวดลายที่จะนํามาทําการแกะสลักได้   ซ่ึงงานวิจัยครั้งนี้สามารถนําไปสร้างต้นแบบ
ลวดลายแกะสลักไม้ดังท่ีได้กล่าวไว้ข้างต้น และสามารถช่วยแก้ปัญหาต่าง ๆ  ในด้านการเรียนการ
สอนหรือผู้ ท่ีสนใจตลอดจนชุมชนท่ีประกอบอาชีพทางด้าน   งานแกะสลักไม้และยังทําให้เกิด
ประสิทธิภาพและประสิทธิผลในการสร้างผลิตภัณฑ์งานไม้แกะสลัก 

ผลิตภัณฑ์ไม้แกะสลักนับเป็นงานศิลปะแขนงหนึ่งที่มีความงามของรูปทรงที่ประกอบด้วยระยะ
หรือต้ืนลึกของพ้ืนผิวที่กระทบต่อแสงแล้วสะท้อนเข้าตา  ทําให้เกิดมิติทางการมองเห็นเป็นรูปทรง
ต่างๆ  งานแกะสลักโดยทั่วไปสามารถแบ่งออกเป็น 3 รูปแบบใหญ่ๆได้แก่ งานแกะสลักนูนตํ่า งาน
แกะสลักนูนสูงและงานแกะสลักลอยตัว  งานไม้แกะสลักมีอยู่มากมายหลายชนิดซ่ึงเป็นได้ท้ังงาน
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ทัศนศิลป์และงานประยุกต์ศิลป์  สําหรับรูปแบบหรือลวดลายท่ีใช้ในการแกะสลักก็มีส่วนสําคัญมาก  
เพราะเป็นส่วนท่ีจะทําให้สามารถเป็นแนวทางในการสร้างงาน  หรือหากต้องการที่จะได้จํานวน
ช้ินงานท่ีเหมือนกันก็สามารถใช้แบบเดียวกันได้  งานเครื่องไม้แกะสลักเป็นงานท่ีสืบทอดภูมิปัญญา
จากโบราณและนับได้ว่ามีคุณค่าย่ิง ปัจจัยที่มีส่วนสําคัญในการออกแบบหรือการพัฒนารูปแบบงาน
แกะสลักไม้  ได้แก่รูปแบบหรือลวดลายท่ีใช้ในการสร้างงาน  ในสมัยก่อนการแกะสลักจะต้องมีการ
วางแผนหรือการสร้างแบบที่เป็นลายเส้นหรือลวดลายเขียนต่างๆ เพ่ือจะนํามาวางทาบบนไม้ให้เห็น
เป็นลายเส้นเพ่ือลงคมสิ่วตามแบบ  สําหรับในปัจจุบันการเขียนแบบโดยการใช้คอมพิวเตอร์เพ่ือช่วย
ในการออกแบบและเขียนแบบ  เป็นสิ่งที่มีบทบาทและมีความสําคัญอย่างย่ิง  คอมพิวเตอร์สามารถ
สร้างฐานข้อมูลเกี่ยวกับลวดลายแกะสลักได้เป็นอย่างดี  ไม่ว่าจะเป็นลวดลายสมัยโบราณที่เป็นศิลปะ 
หรือลวดลายท่ีสร้างขึ้นมาใหม่ก็ตาม  การเขียนแบบลวดลายแกะสลักโดยใช้คอมพิวเตอร์สามารถสร้าง
ความลงตัวหรือรูปแบบใหม่ๆ ท่ีทําให้การสร้างงานแกะสลักมีคุณค่าและยังสามารถสร้างสรรค์ได้อย่าง
ไม่รู้จบ 

งานออกแบบลวดลายเพื่อใช้สําหรับการแกะสลักไม้  จะเป็นการเขียนลายหรือออกแบบมา
เพ่ือใช้ในการแกะสลักไม้โดยตรง   เพราะการแกะสลักไม้มีส่วนที่มีความแตกต่างกับงานเขียนหรือ
ลวดลายท่ีสร้างขึ้นเพ่ือใช้ในการเขียนลาย เช่นลายรดน้ํา หรือลวดลายในงานจิตรกรรมไทย หรือ 
ลวดลายอ่ืน ๆ  ความแตกต่างท่ีว่านี้ได้แก่ช่วงว่างระหว่างลายหรือเรียกกันว่าช่องไฟ  นั้นต้องมีความ
แตกต่างกันออกไป  โดยเฉพาะลายที่เขียนมาเพ่ืองานแกะสลักไม้ผู้เขียนจะต้องคํานึงถึงเร่ืองของการ
วางสิ่วหรือการวางเคร่ืองมือแกะสลักไม้ให้ได้ตามลวดลายที่กําหนด  ซ่ึงถ้าหากเป็นลวดลายประเภท
ลายรดน้ําหรือลายอ่ืน ๆ ก็ไม่สามารถนํามาใช้ในการแกะสลักไม้ได้  ซ่ึงหากนํามาใช้ก็ต้องทําการแก้ไข
หรือปรับลวดลายขึ้นมาใหม่   
 ความหมายของการแกะสลักไม้  การแกะสลักหมายถึงการนําส่วนของเนื้อไม้ออกบางส่วน
โดยใช้เครื่องมือ เครื่องจักรหรือเครื่องทุ่นแรง เพ่ือให้ได้รูปทรงตามแบบหรือตามท่ีต้องการ  การ
แกะสลักอาจทําจากวัสดุอ่ืน ๆท่ีไม่ใช้ไม้ก็ได้เช่นการแกะสลักหิน  การแกะสลักผักผลไม้ การแกะสลัก
งาช้างหรือกระดูกสัตว์  การอาจกล่าวได้ว่าเป็นการสร้างงานในลักษณะลบซ่ึงหมายถึงการเอาออก
อย่างเดียวเพ่ือให้ได้รูปทรง   โดยมีความแตกต่างกับการป้ันซ่ึงเป็นการสร้างงานในลักษณะบวกและ
ลบ  หมายความว่าการป้ันสามารถเพ่ิมเข้าหรือเอาออกได้  งานแกะสลักไม้มีประวัติมายาวนานต้ังแต่
งานท่ีเป็นงานศิลปะยุคโบราณ งานแกะสลักสามารถพบเห็นทั่วไปไม่ว่าจะเป็นศิลปะทางซีกโลก
ตะวันตกและตะวันออก  การสร้างงานแกะสลักของไทยมีความสวยงดงามในรูปแบบที่มีความอ่อน
ช้อย แต่เดิมการแกะสลักอาจจะถูกสร้างเพ่ือใช้ในการสร้างรูปเคารพหรือเพ่ือตกแต่งอาคาร ประสาท
ราชวัง  ในปัจจุบันนี้งานแกะสลักสามารถพบเห็นและสามารถซ้ือหาได้จากผลิตภัณฑ์ชุมชนงาน
แกะสลักโดยท่ัวไปสามารถแบ่งออกเป็น 3 ลักษณะได้แก่  
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1.งานแกะสลักนูนตํ่า หมายถึงการแกะสลักท่ีมีความนูนน้อยจนแทบจะไม่รู้สึกถึงความ
แตกต่างระหว่างพ้ืนและรูปทรง งานแกะสลักนูนตํ่าอาจเป็นการแกะสลักท่ีเป็นลักษณะท่ีเป็นลายเส้น
ยกตัวอย่างเช่นเหรียญกษาปณ์ 

2. งานแกะสลักนูนสูง  หมายถึงการแกะสลักท่ีมีความนูนค่อนข้างมากส่วนที่ถูกแกะสลักจะ
สามารถมองเห็นได้ชัดเจนหรือเกือบมองเห็นได้รอบ งานแกะสลักนูนสูงเป็นวิธีการแกะสลักท่ีเป็นที่
นิยมใช้ในการแกะสลักไม้ท่ีเป็นลวดลายต่างๆ ยกตัวอย่างเช่นรูปปั้นท่ีฐานอนุสาวรีย์ประชาธิปไตย 

3. งานแกะสลักลอยตัว หมายถึงการแกะสลักท่ีสามารถมองเห็นได้รอบตัวช้ินงานซ่ึงงาน
แกะสลักลอยตัวจะใช้วัตถุดิบที่ มีขนาดใหญ่และเหมาะสมกับงาน ตัวอย่างเช่น งานแกะสลัก
พระพุทธรูปไม้แกะสลัก  งานแกะสลักตุ๊กตาของที่ระลึกต่าง ๆ  

เครื่องมือที่ใช้สําหรับงานแกะสลักไม้  สิ่งท่ีจะขาดไม่ได้สําหรับงานแกะสลักไม้ได้แก่สิ่ว  ซ่ึง
เป็นเครื่องมือสําคัญอย่างมากในการสร้างงานแกะสลักไม่ว่าจะเป็นการแกะสลักนูนสูง  นูนตํ่าหรือ
แกะสลักลอยตัว  การแกะสลักจําเป็นต้องใช้สิ่วให้ที่มีรูปแบบต่าง ๆ เพ่ือความหลากหลายของ
ลวดลายที่ได้จากงานแกะสลัก การวางสิ่วตามแบบที่ได้เขียนไว้มีความจําเป็นอย่างย่ิง  เพราะการท่ีมี
ส่ิวท่ีมีขนาดหลากหลายจะทํางานได้ถูกต้องตามแบบท่ีได้ออกแบบไว้   
 สิ่วเป็นเครื่องมือที่ทํางานได้รวดเร็วมากโดยมีส่วนปลายเป็นเหล็กคมและ  ส่วนด้ามท่ีทําด้วย
ไม้หรือไฟเบอร์  คมของส่ิวมีท้ังท่ีเป็นแนวตรงหรือแนวโค้งเพ่ือใช้สําหรับการเซาะเนื้อไม้ออกโดยไม่ทํา
ให้เนื้อไม้แตก  การจําแนกสิ่วโดยทั่วไปมักจะจําแนกตามระยะแนวส่ิวไม่ว่าจะเป็นแนวโค้งหรือแนว
ตรง เลิศพงษ์ ชีวพัฒนพันธ์ุได้จําแนกสิ่วสําหรับงานเคร่ืองไม้ไว้ 3 ชนิดได้แก่  
 1. สิ่วปากบาง  หมายถึงสิ่วท่ีใช้สําหรับการปาด ตอก เฉือน หรือแซะปากไม้  สิ่วชนิดน้ีมี
ลักษณะที่มีความกว้างมากกว่าความหนาของสิ่ว  หรือคล้ายกับใบกบใสไม้โดยท่ัวไปแล้วสิ่วจะมีความ
กว้างต้ังแต่ครึ่งน้ิวถึงสองนิ้ว สิ่วปากบางจะมีส่วนประกอบ 2 ส่วนเช่นเดียวกับสิ่วชนิดอ่ืน ๆ คือ ส่วนท่ี
เป็นใบสิ่วและส่วนที่เป็นด้ามซ่ึงอาจทําด้วยไม้หรือไฟเบอร์ 

2. ส่ิวเดือย  หมายถึงสิ่วที่ใช้ในการเจาะรูเพ่ือใช้ประกอบกับเดือย  โดยลักษณะรูปร่างท่ีมี
ความแตกต่างจากสิ่วปากบางตรงท่ีสิ่วเดือยจะมีความหนาของใบสิ่วอย่างเห็นได้ชัดเจน  หรือมี
ลักษณะเป็นเหล็กกล่องหรือเหล็กรูปตัดเป็น 4 เหลี่ยม สิ่วชนิดนี้ทนต่อแรงตอก แรงงัดได้มาก  ขนาด
ของสิ่วเดือยมีต้ังแต่1 /8 - 3/4 นิ้วด้านหน้าจะมีลักษณะเป็นแนวเฉียงจากด้ามถึงคมสิ่วโดยคมสิ่วจะ
ลาดเอียง 60 องศา  ส่วนที่เป็นคมอยู่ท่ีส่วนล่าสุดของหลังคมสิ่วกับเส้นความลาดเฉียงจากหน้าสิ่วมา
บรรจบกัน  ส่วนบนสุดของใบสิ่วเป็นด้ามส่ิวทําด้วยไม้กลึงหรือไฟเบอร์  

3. สิ่วแกะสลัก  หมายถึงสิ่วที่ใช้สําหรับงานที่ขุด เซาะ แกะลงบนเนื้อไม้ให้เกิดร่องรอยหรือ
ลวดลายหรือเกิดรูปทรงต่างๆ  สิ่วขุดสลักนับเป็นสิ่วท่ีเหมาะกับงานเครื่องไม้สามารถสร้างงานศิลปะ
ได้มากมายหลากหลายรูปแบบไม่ว่าจะเป็นงานแกะสลักนูนตํ่า  นูนสูง  หรือลอยตัว  สิ่วชนิดนี้
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สามารถใช้งานได้แทบทุกประเภท  ลักษณะของส่ิวแกะสลักจะมีรูปร่างหน้าตาที่มีความหลากหลาย
เช่น สิ่วหน้าตรง  สิ่วเล็บมือหรือรูปตัวยู  สิ่วตัววี  สิ่วหางปลา  สิ่วช้อน  สิ่วเซาะร่อง ฯลฯ 

สําหรับซอฟต์แวร์ท่ีใช้ในด้านการเขียนแบบลวดลาย Illustrator เป็นโปรแกรมคอมพิวเตอร์
กราฟฟิกท่ีมีความเหมาะสมในการใช้เขียนภาพซ่ึงสามารถนํามาประยุกต์ใช้ ในการเขียนลวดลายท่ี
เป็นลายเส้นได้ดีมาก นักออกแบบสามารถท่ีใช้โปรแกรมน้ีทําการออกแบบสร้างสรรค์ได้อย่างสมบูรณ์
แบบ วิธีการเขียนลวดลายแกะสลักไม้ด้วยการใช้โปรแกรม Illustrator จะใช้วิธีการคัดลอกลวดลาย
จากธรรมชาติโดยเป็นภาพถ่ายหรือเป็นภาพวาดมาเป็นแนวทางหรือต้นแบบ โดยใช้วิธีการซ้อนช้ัน
ของช้ินงานหรือทางโปรแกรมเรียกว่าเลเยอร์ (Layer)  ซ่ึงสามารถกําหนดรูปแบบหรือลายละเอียดใน
แต่ละเลเยอร์หรือช้ันของลวดลายได้ ซ่ึงในแบบหนึ่งแบบสามารถกําหนดให้แบบแสดงให้เห็นลวดลาย
ท่ีเขียนได้ท้ังหมดหรือตามต้องการได้ตามความพอใจ 
โปรแกรม Illustrator  

เป็นโปรแกรมยอดนิยมทางด้านงานกราฟฟิก ไม่ว่าจะเป็นคอมพิวเตอร์เครื่อง PC หรือ 
Macintosh โดยโปรแกรมนี้จะทําให้นักออกแบบดีไซด์ท้ังหลายสามารถวาดภาพลงในเครื่อง
คอมพิวเตอร์ไม่ว่าจะเป็นนักออกแบบสาขาใดก็ตาม เช่นงานโฆษณา งานประชาสัมพันธ์ ภาพการ์ตูน 
หรือการทํางานกราฟิกและเว็บไซด์อีกด้วย  การประมวนผลเพ่ือแสดงภาพของโปรแกรมต่างๆใน
เครื่องคอมพิวเตอร์น้ัน มีการเก็บไว้อยู่ด้วยกัน 2 รูปแบบหลักๆ ได้แก่ การเก็บผลแบบเวคเตอร์
(Vector) และการเก็บผลแบบบิตแม็บ (Bitmap) โดยการประมวนผลทั้ง 2 จะมีข้อแตกต่างกันซ่ึง
ขึ้นอยู่กับแต่ละโปรแกรมที่ใช้ด้วย  การประมวลผลแบบเวคเตอร์สังเกตได้ง่ายๆว่าต้องเป็นภาพ
ลายเส้นท่ีวาดด้วยโปรแกรมในเคร่ืองคอมพิวเตอร์เท่านั้น ไม่ว่าจะเป็นโปรแกรม Freehand Corel 
Draw หรือ Illustrator ภาพเหล่าน้ีจะมีการคํานวณประมวลผลในรูปแบบเวคเตอร์ทางคณิตศาสตร์
โดยสีสันเหล่าน้ีไม่แตกตัวเม่ือทําการซูมเพ่ือขยายภาพในระยะใกล้ 

บุญญาดา  ช้อนขุนทด ได้กล่าวเก่ียวกับโปรแกรม Illustrator ไว้ว่า  เม่ือเรานึกภาพของงาน
ศิลปะในอดีต  หลาย ๆ คนอาจนึกถึงภาพของรูปวาดตามผนังโบสถ์  ภาพวาดบนผืนผ้าใบติดตามผนัง
บ้าน  รูปป้ันตามอนุสรณ์สถาน  งานแกะสลักไม้หรือสถาปัตยกรรมต่างๆ ซ่ึงเหล่าน้ีเป็นศิลปะบริสุทธ์
ท่ีสวยงามถูกสร้างสรรค์ขึ้นด้วยฝีมือมนุษย์โดยตรง  ไม่ว่าจะเป็นการวาด ป้ัน แกะ หล่อ สร้างขึ้นมา 
แต่ท้ังน้ีความเจริญก้าวหน้าของเทคโนโลยีในปัจจุบัน  ก็เข้ามามีบทบาทกับวิธีการสร้างงานศิลปะ
เช่นเดียวกันกับงานแขนงอ่ืนๆ  ซ่ึงการนําเอาเทคโนโลยีคอมพิวเตอร์มาใช้น้ัน  จะทําให้สามารถ
ทํางานได้อย่างรวดเร็วลงตัว แม่นยําและถูกต้อง  รวมไปถึงการสร้างงานด้านการวาดภาพแบบท่ี
เรียกว่าจิตรกรรม  จากการวาดที่ต้องใช้ดินสอ  สี  ผ้าใบ  กระดาษ  ผนังและอ่ืนๆ  อีกทางเลือกหนึ่ง
คือการวาดภาพด้วยโปรแกรมคอมพิวเตอร์  ซ่ึงจะช่วยในการออกแบบ  วางโครงร่าง  จัด
องค์ประกอบ  ปรับแต่งรายละเอียดรวมไปถึงใช้เทคนิคพิเศษกับภาพ  เช่นฟิลเตอร์เอฟเฟ็คต์  ทั้งน้ี
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หน่ึงในโปรแกรมด้านการวาดภาพท่ีได้รับความนิยมอย่างสูงขณะน้ีคือโปรแกรมท่ีช่ือ Illustrator เป็น
โปรแกรมที่นิยมสําหรับผู้สร้างงานศิลปะและนักออกแบบมืออาชีพ  เนื่องจากใช้งานง่าย มีการแบ่ง
ส่วนประกอบหน้าต่างและเครื่องมือเป็นสัดส่วนอย่าชัดเจน  มีความสามารถในการสร้างภาพได้
หลากหลายรูปแบบ เช่นภาพ 2 มิติ และ 3 มิติ ภาพสเกตซ์ ภาพเหมือนจริง  ภาพการ์ตูน  โลโก้  
ไอคอนหรืองานสิ่งพิมพ์  เช่น ป้ายโฆษณา  ปกหนังสือ แผ่นพับ โบรชัวร์  นามบัตร  ออกแบบลายผ้า 
ฉลากผลิตภัณฑ์  รวมไปถึงงานทางด้านเว็บและอุปกรณ์มือถือด้วย  

Illustrator เป็นโปรแกรมวาดภาพกราฟิกแบบเวกเตอร์ ซ่ึงพัฒนาโดยบริษัทอะโดบีซิสเต็มส์ 
รุ่นแรก จัดทําขึ้นในปี ค.ศ. 1986 เพ่ือใช้งานกับเคร่ืองแมคอินทอช และได้พัฒนารุ่นท่ี 2 ออกมาให้ใช้
งานได้กับวินโดวส์ ซ่ึงได้รับความพึงพอใจ และ การตอบรับที่ดีจากผู้ใช้เป็นจํานวนมาก จนปัจจุบัน
สําหรับผู้วิจัยได้ใช้โปรแกรม Illustrator CS3 ในการสร้างลวดลายแกะสลักไม้โดยจะใช้การร่างแบบ
จากกระดาษแล้วนําเข้ามาในเคร่ืองคอมพิวเตอร์เพ่ือทําการดําเนินงานในขั้นตอนต่อไปในบทต่อไป 
จุดเด่นของโปรแกรมIllustrator 
 เป็นโปรแกรม่ีใช้ทํางานด้านกราฟิกตัวหน่ึง  โดยเน้นการสร้างช้ินงานจากการวาดเป็นหลักซ่ึง
เป็นที่นิยมสําหรับนักออกแบบท้ังหลาย  เพ่ือนําไปใช้ในงานด้านต่างๆ ไม่ว่าจะเป็นงานสิ่งพิมพ์  
เสื้อผ้า เว็บเพจ  ออกแบบฉลากและผลิตภัณฑ์  หรืองานโฆษณารวมถึงการวาดภาพแบบ Clipart ท่ี
เห็นในโปรแกรมชุดไมโครซอฟต์ออฟฟิศน่ันเอง  จะเห็นว่าความสามารถของ Illustrator น้ันมีไม่ใช้
น้อยทีเดียว  อาจเปรียบได้เหมือนกับผ้าใบผืนใหญ่ท่ีใช้วาดภาพ  โดยโปรแกรมเตรียมอุปกรณ์ต่าง ๆ 
ไว้ให้  ไม่ว่าจะเป็นดินสอสี  แปรงพู่กัน  ไม่บรรทัด  ยางลบ  สีแบบต่าง ๆ และอุปกรณอ่ืนๆ ให้
เรียบร้อย  โดยขึ้นอยู่กับจินตนาการในการออกแบบและวาดภาพของคุณที่จะขีดเขียนหรือระบาย
ภาพออกมา  ดังจะเห็นได้จากตัวอย่างงานบางส่วนที่สร้างด้วย Illustrator (บุญญาดา  ช้อนขุนทด.
2550:3) 

การศึกษาเกี่ยวกับประวัติความเป็นมาของคอมพิวเตอร์มีความสําคัญเน่ืองจากเราจะได้รู้ถึง
ความเปลี่ยนแปลงในด้านต่าง ๆซ่ึงจะทําให้เรามีความเข้าใจถึงการพัฒนาทางด้านความเจริญก้าวหน้า
ทางด้านวิทยาศาสตร์  ซ่ึงส่งผลโดยตรงเก่ียวกับความเปลี่ยนแปลงหลายๆ สิ่งหลาย ๆอย่าง  
คอมพิวเตอร์ยุคแรกๆ เป็นเครื่องคอมพิวเตอร์ท่ีมีขนาดใหญ่มากโดยมีลักษณะเป็นเครื่องแบบ
อิเล็กทรอนิกส์ดิจิทัลคอมพิวเตอร์ ( Electronic Digital Computer) ในยุคน้ีคอมพิวเตอร์ใช้หลอด
สูญญากาศ (Vacuum Tubes) วงจรไฟฟ้าและมีความเร็วในการทํางานเป็นวินาที (Second) ซ่ีงต้อง
ใช้พลังงานความร้อนสูงในขณะทํางานภาพที่ได้จากโปรแกรมจะเป็นกราฟิกประเภทเวกตอร์  และ
ไฟล์ของโปรแกรมท่ีสามารถใช้งานร่วมกับโปรแกรมกราฟิกอ่ืนๆ ได้ เช่น Page Maker Indesign 
Photoshop Flash AutoCAD ฯลฯ สําหรับเวอร์ช่ัน CS3 นี้ได้ปรับเปลี่ยนการเรียกช่ือส่วนประกอบ
หน้าจอโปรแกรมไปมากพอสมควรเช่นพาเล็ตเปลี่ยนเป็นพาเนล  ทูลบ็อกซ์เปลี่ยนเป็นทูลพาเนลแล
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คอนโทรลพาเล็ตเปลี่ยนเป็นคอนโทรลพาเนล ฯลฯ อีกทั้งยังเพ่ิมลูกเล่นการทํางานอีกหลายเรื่องไม่ว่า
จะเป็น  การเพ่ิมเครื่องมือ Eraser เพ่ือการลบรูปทรงที่ง่ายข้ึน  เพ่ิมเคร่ืองมือ Crop เพ่ือสร้าง Crop 
mark ได้อย่างรวดเร็ว  เพ่ิมคุณสมบัติ Live Color ให้สามารถเปลี่ยนสีออบเจ็คหลายสีได้พร้อม ๆ กัน 
เพ่ิมพาเนล Color Guide ให้สามารถเลือกโทนสีภาพได้กลมกลืนกันมากขึ้น ปรับคุณสมบัติของ
เครื่องมือ Direct Seletion เพ่ือให้เลือกจุดแองเคอร์ได้สะดวก เพ่ิมคุณสมบัติการทํางานร่วมกับ
โปรแกรม Adobe Flash และอ่ืน ๆ (บุญญาดา  ช้อนขุนทด.2550:3) ในส่วนของเครื่องมือใน
โปรแกรม Flash ก็จะมีหน้าตาหรือหน้าท่ีในการทํางานเช่นเดียวกับเครื่องมือวาดภาพของโปรแกรม
Illustrator 
ประเภทขอบกราฟฟิก 

ภาพกราฟฟิกที่ใช้ในคอมพิวเตอร์จะถูกแบ่งตามวิธีการข้อมูลและวิธีแสดงผลออกเป็น 2 
ประเภทใหญ่ๆ ด้วยกัน  คือภาพแบบที่เรียกว่าเวคเตอร์ (Vector Graphics) และภาพแบบบิทแมพ
(Bitmap Images) ซ่ึงข้อแตกต่างระหว่างภาพทั้งสองประเภทจะมีผลต้ังแต่การสร้าง  การแก้ไข  การ
นําเข้าไฟล์ภาพ  และการนําภาพที่สร้างจากโปรแกรมไปใช้กับโปรแกรมอ่ืน  สําหรับงานวิจัยเล่มน้ีก็
จะใช้วิธีนําเข้ามาโดยการสแกนจากการวาดภาพลวดลาย  ท่ีใช้แกะสลักเข้ามาสู่ในโปรแกรมเพ่ือ
ปรับแต่งและแก้ไขลวดลายให้ได้ตามต้องการ  การนําภาพท่ีสร้างจากโปรแกรมไปใช้กับโปรแกรมอ่ืนๆ 
รวมถึงความสามารถในการปรับแต่งเอฟเฟ็คต์หรือลูกเล่นของกราฟฟิกแต่ละประเภทก็ต่างกันออกไป  
บางคําสั่งสามารถใช้ได้เฉพาะภาพแบบเวคเตอร์      หรือบางคําสั่งสามารถใช้ได้เฉพาะภาพแบบบิท
แมพซ่ึงภาพชนิดน้ีบางทีเรียกว่า 

ภาพบิทแมพหรือภาพแบบราสเตอร์ (Raster) ภาพด้านล่างเป็นภาพที่ผู้วิจัยได้ร่างด้วย
ดินสอลงบนกระดาษและทําการสแกนเข้ามาในเครื่องคอมพิวเตอร์ภาพชนิดนี้  จะเป็นภาพท่ี
เหมือนกับภาพที่ถ่ายจากกล้องดิจิทรัลซ่ึงภาพประเภทนี้เราเรียกว่าภาพราสเตอร์  เป็นภาพที่เกิดจาก
จุดสีท่ีเรียกว่าพิกเซลท่ีเรียงต่อกันเป็นรูปร่างบนพ้ืนที่มีลักษณะเป็นตาราง  โดยแต่ละพิกเซลจะมีค่า
ของตําแหน่งและค่าสีของตัวเอง  ภาพหน่ึงภาพจะประกอบด้วยพิกเซลหลาย ๆ พิกเซลรวมกันแต่
เนื่องจากพิกเซลมีขนาดเล็กมาก  ภาพที่เห็นจึงมีความละเอียดสวยงามไม่เป็นกรอบสี่เหลี่ยม  ความ
ละเอียดหรือความคมชัด (Resolution) ของภาพข้ึนอยู่กับจํานวนพิกเซลที่กําหนดไว้แล้วเป็นค่าท่ี
แน่นอน  ดังนั้นเม่ือการขยายภาพจะเกิดปัญหาคือ  เห็นภาพเป็นกรอบสี่เหลี่ยมเล็ก ๆ หลาย ๆ จุด  
ภาพบิทแมพเป็นภาพท่ีนิยมใช้กันในภาพถ่ายหรือภาพวาดบางประเภท     เน่ืองจากสามารถไล่โทนสี
และแสงเงาได้เหมือนจริงที่สุดโปรแกรมท่ีนิยมใช้กันมากท่ีสุดในการสร้างภาพบิทแมพได้แก่โปรแกรม
Photoshop 
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ภาพท่ี 1  ภาพบิทแมพหรือภาพแบบราสเตอร์ (Raster) 

 
ภาพแบบเวคเตอร์ (Vector) เป็นภาพที่ประกอบไปด้วยเส้นตรง  ส่วนโค้ง  และรูปทรง

เรขาคณิตซ่ึงเก็บอยู่ในรูปของคําสั่งโปรแกรมหรือสมการทางคณิตศาสตร์  ซ่ึงโดยสามารถกําหนด
คุณสมบัติเกี่ยวกับเส้นและพ้ืนได้ เช่น ภาพที่ประกอบไปด้วยส่วนโค้งหลายส่วนท่ีเช่ือมกันกลายเป็น
รูปทรง  โดยสีพ้ืนสีแดงเกิจากสีของเส้นโครงร่างนั้น ๆ กับพ้ืนท่ีผิวภายในเม่ือมีการแก้ไขภาพก็จะเป็น
การแก้ไขคุณสมบัติของเส้น  และโปรแกรมจะคํานวณสร้างภาพให้ใหม่เสมอ  ทําให้ภาพไม่สูญเสีย
คุณภาพเม่ือทําการขยาย  ยกตัวอย่างเช่นภาพ Clipart ที่มีให้ใช้ในโปรแกรมชุดไมโครซอฟท์ออฟฟิศ 
หากขยายภาพ Clipart จะเห็นได้ว่าภาพไม่มีการสูญเสียความละเอียด  ภาพไม่ผิดเพ้ียนและเบลอมัว  
โปรแกรมที่ใช้สร้างภาพกราฟฟิกแบบเวคเตอร์จะเป็นโปรแกรมที่มีความสามารถในการวาดภาพเป็น
รูปทรงต่าง ๆ เช่นโปรแกรม Flash Illustrator Corel Draw ฯลฯ 

สําหรับงานวิจัยเล่มน้ีผู้วิจัยได้สร้างลวดลายแกะสลักเป็นภาพลักษณะเวคเตอร์เพราะจะทําให้
การทํางานสะดวกมากขึ้นคือสามารถแก้ไขงานได้ตามต้องการและท่ีสําคัญไฟล์งานไม่แตกเม่ือขยาย
ใหญ่ขึ้มมาก ๆ ดังนั้นก่อนท่ีจะนําภาพท่ีเป็นต้นแบบหรือภาพที่ผ่านการสแกนมาก็จะได้เป็นภาพ
แบบพิทแมพก็ตาม  แต่เม่ือผ่านโปรแกรมประเภทเวคเตอร์ก็จะได้ไฟล์ภาพเวคเตอร์เพ่ือนํามาใช้หรือ
แก้ไขปรับปรุงลวดลายต่อไปได้อย่างสะดวกรวดเร็ว ภาพเวคเตอร์จะเป็นภาพที่เน้นลายเส้นมากกว่า
ส่วนอ่ืน ๆ อย่างไรก็ดีภาพเวคเตอร์ก็จะทํางานในลักษณะการเทสีได้ดีเช่นกันแต่เฉดสีอาจจะแตกต่าง
กับภาพแบบบิทแมพกันออกไป  จากภาพด้านบนเป็นบิทแมพทําให้ไม่ได้ลายละเอียดจึงเป็นเพียงแค่
เป็นภาพต้นแบบ  ส่วนภาพด้านล่างที่เป็นเวคเตอร์ก็จะมีความคมชัดและสามารถนําไปใช้งานได้โดย
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จะย่อหรือขยายได้ตามต้องการโดยจะมีความคมชัดมากและจะไม่มีการแตกเม่ือขยายใหญ่มาก ๆ 
สําหรับผู้วิจัยได้นําลวดลายมาแก้ไขได้ในภายหลังหรือสามารถขยายให้เข้ากับพ้ืนท่ีไม้ท่ีมีอยู่ 

 

 
 

ภาพท่ี 2  ภาพแบบเวกเตอร์ (vecter) ท่ีได้จากการใช้โปรแกรม Illustrator 

 
องค์ประกอบของระบบคอมพิวเตอร์ หมายถึง ส่วนประกอบขอบคอมพิวเตอร์ทุกส่วนท่ี

นํามารวมกันแล้วทําให้เครื่องคอมพิวเตอร์สามารถใช้งานได้และสามารถใช้ประโยชน์ได้ โดยมี
องค์ประกอบท่ีสําคัญดังน้ี 

1. เครื่องและอุปกรณ์หรือฮาร์ดแวร์  (Hardware) หมายถึงตัวเคร่ืองคอมพิวเตอร์และ
อุปกรณ์ท่ีเก่ียวข้องทั้งหมดท่ีอยู่ในระบบคอมพิวเตอร์ ได้แก่ จอภาพ เมนบอร์ด ตลอดจนสายไฟทุก
เส้นที่อยู่ในตัวเคร่ือง ฯลฯ นอกจากน้ียังสามารถแบ่งการทํางานของฮาร์ดแวร์ออกเป็นประเภทได้แก่
หน่วยรับข้อมูล ( Input Device) หมายถึง หน่วยท่ีมีหน้าท่ีในการรับข้อมูลหรือคําสั่งจากโปรแกรม
เพ่ือนําข้อมูลเข้าสู่เครื่องคอมพิวเตอร์โดยส่งตรงไป CPU เพ่ือทํางานในขั้นตอนต่อไป สําหรับอุปกรณ์
ท่ีใช้ในการรับข้อมูลได้แก่ แป้นพิมพ์ เมาส์ เครื่องสแกนเนอร์ ฯลฯหน่วยประมวลผลกลาง (Central 
Processing Unit) หมายถึงแผงวงจรอิเล็กทรอนิกส์ที่อยู่ภายในเคส (Case) ท่ีเรียกกันว่า CPU ถือได้
ว่าเป็นสมองของการทํางานของเคร่ืองคอมพิวเตอร์ซ่ึงมีความสําคัญที่สุดในการทํางานก็ว่าได้  
หน่วยความจําสํารอง (Secondary Storage Unit) หมายถึงหน่วยท่ีใช้เป็นสื่อในการเก็บข้อมูล คําสั่ง 
หรือโปรแกรม ตลอดจนผลลัพธ์ต่างๆ เพ่ือใช้ในการทํางานต่อไปและการเก็บข้อมูลในหน่วยความจํา
สํารองเป็นการเพ่ิมประสิทธิภาพในการจดจําข้อมูลของเครื่องคอมพิวเตอร์ อุปกรณ์ท่ีใช้สําหรับเก็บ
ข้อมูลได้แก่ แผ่นCD แผ่น DVD ฮาร์ดดิสก์ (Hard disk) สําหรับหน่วยความจําหรือแรม (Ram) เป็น
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ส่วนที่ใช้เก็บข้อมูลช่ัวคราวขณะที่ CPU ประเมินผลอยู่ หรือเรียกง่าย ๆ ว่าแรมมีหน้าท่ีจัดเก็บข้อมูล
จาก CPU โดยตรงก่อนท่ีจะส่งไปยังฮาร์ดดิสก์หน่วยแสดงผล (Output Unit) เป็นหน่วยท่ีทําหน้าท่ี
แสดงผลลัพธ์จากการประมวลผลข้อมูลเรียบร้อยแล้ว จากนั้นหน่วยความจําก็จะนําผลลัพธ์ท้ังหมดมา
แสดงออกในรูปท่ีผู้ใช้สามารถเข้าใจได้ง่าย เช่น ในรูปรายงาน รูปกราฟ รูปตรางหรือรูปภาพต่าง ๆ 
อุปกรณ์ท่ีใช้ในการแสดงผลได้แก่ จอภาพ หรือเคร่ืองพิมพ์ 

2. โปรแกรมใช้งาน (Software) หมายถึงชุดหรือคําสั่งโปรแกรมที่เขียนหรือสร้างขึ้นอย่างมี
ลําดับขั้นตอน เพ่ือทําหน้าที่ควบคุมการทํางานของเคร่ืองคอมพิวเตอร์และฮาร์ดแวร์ต่าง ๆ ทํางาน 
ซอฟต์แวร์เป็นสิ่งท่ีไม่สามารถจับต้องได้แต่สามารถมองเห็นได้ เม่ือเขียนออกมาเป็นคําสั่งหือที่เรียกว่า
ภาษาคอมพิวเตอร์ซอฟต์แวร์น่ันเอง นอกจากน้ียังแบ่งซอฟต์แวร์ออกเป็น 2 ประเภทได้แก่ ซอฟต์แวร์
ระบบเช่นระบบปฏิบัติการ Windows, Linux, Dos, Max OS ฯลฯ และซอฟต์แวร์ประยุกต์ เช่น
โปรแกรม Microsoft office Adobe Photoshop ฯลฯซอพต์แวร์ระบบ(System Software) 
หมายถึงโปรแกรมที่สร้างขึ้นมาเพ่ือทําหน้าท่ีควบคุมการทํางานของเครื่องคอมพิวเตอร์ท้ังหมด และ
รวมถึงการควบคุมการทํางานของอุปกรณ์ต่าง ๆภายในเคร่ืองคอมพิวเตอร์ให้ทํางานสัมพันธ์กันหรือ
ทํางานได้อย่างมีประสิทธิภาพ ซอพต์แวระบบท่ีรู้จักกันโดยทั่วไปได้แก่ ระบบปฏิบัติการ Windows 

3. ผู้ใช้งานคอมพิวเตอร์ (People ware) หมายถึงผู้ท่ีใช้งานหรือผู้ท่ีทํางานอยู่กับเครื่อง
คอมพิวเตอร์ซ่ึงรวมถึงผู้ที่มีความรู้ความชํานาญเฉพาะด้านเช่น โปรแกรมเมอร์ นักวิเคราะห์ระบบ 
บุคคลต่าง ๆ เหล่าน้ีสามารถแยกออกเป็นประเภทต่างๆ ท่ีเกี่ยวข้องกับเครื่องคอมพิวเตอร์ได้ดังน้ี ผู้ท่ี
ใช้งานคอมพิวเตอร์ท่ัวไป (User) หมายถึง ผู้ท่ีใช้งานด้านคอมพิวเตอร์ท่ัวๆไปเช่นการพิมพ์งานด้าน
เอกสาร นักออกแบบ นักเล่นเกมส์ ผู้ส่งจดหมายอิเล็กทรอนิกส์ หรือการดูหนังฟังเพลง ฯลฯ โดย
ภาพรวมแล้วผู้ใช้คอมพิวเตอร์เหล่านี้ไม่มีความจําเป็นต้องมีความรู้ทางด้านเทคนิคต่างๆ ของระบบ
คอมพิวเตอร์มากนัก ซ่ึงอาจจะพอรู้จักวิธีการใช้งานในเบ้ืองต้นเท่าน้ัน หรืออาจจะเป็นผู้ใช้เครื่อง
คอมพิวเตอร์ท่ัว ๆ ไปเช่นใช้ในสํานักงาน หน่วยงานราชการ ห้องเรียนหรือในสถานศึกษาแม้กระท่ังใน
บ้านหรือใช้ในครอบครัวผู้ดูแลและซ่อมบํารุง (Supporter) หมายถึงผู้ที่มีหน้าท่ีในการดูแลรักษา
เครื่องคอมพิวเตอร์ให้อยู่ในสภาพท่ีพร้อมใช้งานในที่นี้อาจหมายถึงช่างเทคนิคหรือช่างซ่อมก็ได้ผู้เขียน
โปรแกรม (Programmer) หมายถึงนักออกแบบและวิเคราะห์ระบบและสามารถนํามาเขียนโปรแกรม
ตามความต้องการของผู้ใช้งาน เพ่ือให้ได้โปรแกรมที่ถูกต้องตามความต้องการขององค์กร หน้าท่ีหลัก
ของโปรแกรมเมอร์หรือผู้เขียนโปรแกรมสามารถใช้ภาษาคอมพิวเตอร์ได้เป็นอย่างดี  ตลอดจน
สามารถพัฒนาโปรแกรมให้ผู้ อ่ืนนําไปใช้ ผู้ออกแบบและวิเคราะห์ระบบคอมพิวเตอร์ (System 
Analysis) หมายถึง   ผู้ท่ีมีหน้าที่พิจารณาว่าองค์กรหรือหน่วยงานต่าง ๆ มีความต้องการใช้งาน
คอมพิวเตอร์แบบใด ซ่ึงหมายถึงการพิจารณาการใช้งานให้เหมาะสมกับการใช้งานอีกด้วย นัก
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ออกแบบและวิเคราะห์อาจจะไม่จําเป็นต้องเขียนโปรแกรมเองเพียงแต่สามารถวิเคราะห์ระบบต่าง ๆ  
แล้วส่งไปยังผู้เขียนโปรแกรมอีกที 
ประเภทของคอมพิวเตอร์ 
เครื่องคอมพิวเตอร์สามารถแบ่งออกเป็นประเภทใหญ่ ๆ ได้ 3 ประเภทได้แก่ 

1. คอมพิวเตอร์สําหรับงานเฉพาะด้าน (Super Computer) หรือเรียกอีกอย่างว่า ซุปเปอร์
คอมพิวเตอร์ เครื่องคอมพิวเตอร์ชนิดนี้เป็นเคร่ืองคอมพิวเตอร์ท่ีมีขนาดใหญ่ท่ีให้ประสิทธิภาพในการ
ทํางานที่ค่อนข้างสูง โดยมีการประมวลผลท่ีสูงสุดมักจะใช้สําหรับงานระดับประเทศหรืองานท่ีมีการ
ค้นคว้าวิจัยขององค์กรขนาดใหญ่เช่นงานทางด้านวิทยาศาสตร์ 

2. คอมพิวเตอร์สําหรับองค์กร ( Mainframes Computer) เป็นคอมพิวเตอร์ท่ีมีขนาดใหญ่
รองลงมาจากซุปเปอร์คอมพิวเตอร์ มักจะใช้กับองค์กรขนาดใหญ่ที่ ต้องการคอมพิวเตอร์ท่ีมี
ประสิทธิภาพสูงสําหรับนําไปใช้ในการทําหน้าท่ีเป็นศูนย์กลางการให้บริการข้อมูลต่าง ๆ กับผู้ท่ีเข้าใช้
เป็นจํานวนมาก สําหรับสาเหตุท่ีเรียกช่ือว่าเมนเฟรมคอมพิวเตอร์ก็เน่ืองมาจากคร้ังแรกที่สร้าง
คอมพิวเตอร์ลักษณะน้ีได้สร้างไว้บนฐานรองรับท่ีเรียกว่า คัสซ่ี (Chassis) โดยมีช่ือเรียกฐานรองรับนี้
ว่า เมนเฟรม (วัลภา  ระวังนาม.2545:20)  ในปัจจุบันเราจะไม่ค่อยได้พบเห็นเคร่ืองคอมพิวเตอร์ชนิด
น้ีมากนักเน่ืองจากว่ามีเครื่องคอมพิวเตอร์พัฒนาไปไกลมากจนมีขนาดเล็กลงอย่างมากแต่
ประสิทธิภาพเพ่ิมมากขึ้น 

3. คอมพิวเตอร์สําหรับองค์กรขนาดกลางและขนาดเล็กเรียกกันว่า มินิคอมพิวเตอร์ (Mini 
Computer) เป็นเครื่องคอมพิวเตอร์ท่ีมีขนาดเล็กลงมาจากเครื่องเมนเฟรมคอมพิวเตอร์ ซ่ึงในปัจจุบัน
ปี 2008 มีขนาดที่ใกล้เคียงกับคอมพิวเตอร์ท่ีใช้ตามบ้านโดยท่ัวไป   คอมพิวเตอร์ชนิดน้ีมักจะนําไปใช้
ในการทําหน้าท่ีควบคุม ดูแลและจัดการระบบเครือข่ายภายในองค์กรท้ังขนาดกลางและขนาดเล็ก ซ่ึง
ส่วนใหญ่มักจะเรียกกันว่าเคร่ืองเซิร์ฟเวอร์ (Server) หรือเครื่องแม่ข่าย ในปัจจุบันผู้ประกอบการ
ธุรกิจขนาดกลางถึงขนาดใหญ่มักนิยมใช้เครื่องคอมพิวเตอร์เซิร์ฟเวอร์มาเป็นตัวหลักและใช้เครื่อง PC 
เป็นเพียงเคร่ืองประมวลผลช้ันต้นท่ีโต๊ะทํางานหรือในแผนเล็กๆ เม่ือได้ผลลัพธ์แล้วก็จะส่งเก็บไว้ท่ี
เครื่องแม่ข่าย 

4. คอมพิวเตอร์สําหรับผู้ท่ีใช้งานท่ัวไปหรือเรียกว่าไมโครคอมพิวเตอร์ (Micro Computer) 
เป็นคอมพิวเตอร์ท่ีมีขนาดเล็กท่ีสุดได้แก่เครื่องคอมพิวเตอร์ที่ใช้กันทั่วไปตามบ้านหรือตามสํานักงาน
ท่ัวไปหรือสถานศึกษา  คอมพิวเตอร์ชนิดนี้รวมถึงเคร่ืองคอมพิวเตอร์พกพาหรือที่เราเรียกกันว่า 
Laptop หรือ Notebook ท้ังนี้ยังรวมไปถึงเครื่องคอมพิวเตอร์แบบติดกระเป๋าท่ีเรียกว่า Pocket PC/ 
Palm และเคร่ืองคิดเลข  เครื่องคอมพิวเตอร์ชนิดน้ีมีบทบาทหน้าท่ีสําคัญในการใช้งานเนื่องจากมี
ราคาท่ีไม่แพง มีความสะดวก สามารถซ่อมหรือแก้ไขได้เองหากเกิดปัญหาข้ึนมา ในปัจจุบันเครื่อง 
Notebook ได้มีบทบาทการใช้งานมากขึ้นเพราะความสะดวกสบายคล่องตัวสามารถพกพาไปได้ทุก
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หนทุกแห่งและที่สําคัญประสิทธิภาพของ Notebook มีขีดความสามารถท่ีใช้งานเคร่ืองแบบต้ังโต๊ะ 
(Desktop) ได้อย่างสบาย 
โปรแกรมวาดดภาพแบบลายเส้น Illustrator  

Illustrator คืออะไร และทําอะไรได้บ้างโปรแกรมพื้นฐานท่ีนักออกแบบทุกคนต้องเรียนรู้ใน
การสร้างงานกราฟฟิกมี 2 ชนิด คือโปรแกรมประเภทวาดภาพ และโปรแกรมประเภทตกแต่งภาพ
Illustrator คือ โปรแกรมท่ีใช้ในการวาดภาพ โดยจะสร้างภาพที่มีลกัษณะเป็นลายเส้น หรือที่เรียกว่า 
Vector Graphic จัดเป็นโปรแกรมระดับมืออาชีพที่ใช้กันเป็นมาตรฐานในการออกแบบระดับสากล
สามารถทํางานออกแบบต่างๆ ได้หลากหลาย ไม่ว่าจะเป็นสิ่ งพิมพ์ บรรจุภัณฑ์ เ ว็บ และ
ภาพเคลื่อนไหวตลอดจนการสร้างภาพเพ่ือใช้เป็นภาพประกอบในการทํางานอ่ืนๆ เช่น การ์ตูน 
ภาพประกอบหนังสือ เป็นต้นแนะนําเคร่ืองมือต่างๆ ในโปรแกรมเม่ือเราเข้าสู่โปรแกรมหรือเม่ือเรา
สร้างไฟล์ใหม่ด้วยการคลิกที่เมนู File>New จะปรากฏหน้าตาของโปรแกรมเหมือนตัวอย่างข้างล่างน้ี 
 

 
 

ภาพท่ี 3  ภาพการใช้โปรแกรม Illustrator ในการเขียนลาย 
 

หน้าตาโดยรวมของโปรแกรม Illustrator 
1. แถบคําสั่ง (Menu Bar) 
2. แถบเคร่ืองมือ (Tool Box) 
3. พ้ืนท่ีทํางาน (Art Board) 
4. จานเคร่ืองมือต่างๆ (Palette) 
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ภาพท่ี 4  ภาพแถบเมนูบาร ์
 
แถบคําส่ัง (Menu Bar)  
เป็นเมนูคําสั่งหลักโปรแกรม แบ่งออกเป็นหมวดหมู่ต่างๆ ดังน้ี 
File: เป็นหมวดของคําสั่งท่ีจัดการเกี่ยวกับไฟล์และโปรแกรมท้ังหมด ไม่ว่าจะเป็นการ เปิด-ปิดไฟล์ 
การบันทึกไฟล์ การนําภาพเข้ามาใช้ (Place) ตลอดจนการออกจากโปรแกรม (Exit) 
Edit: เป็นหมวดของคําสั่งที่จัดการแก้ไข เช่น Undo Cut Copy Paste Select รวมทั้งการกําหนด
คุณสมบัติต่างๆ ท่ีมีผลต่อการปรับแต่งภาพด้วย เช่นการสร้างรูปแบบ (Define Pattern) การ
กําหนดค่าสี (Color Setting) เป็นต้น 
Type: เป็นหมวดของคําสั่งท่ีใช้จัดการตัวหนังสือ เช่น Fonts Paragraph การใช้ตัวอักษรจะ
เหมือนกับโปรแกรมอ่ืน ๆ เช่นโปรแกรมทางด้านเอกสาร เราสามารถติดต้ังฟอนต์เพ่ิมเติมได้โปรแกรม
Illustrator จะทํางานกับอักษรได้ตามต้องการและจะแปลงเป็นกราฟฟิกหรือรูปภาพได้เม่ือต้องการ
สร้าง Effect ต่างๆ เพ่ิมเติมลงไปในอักษรน้ัน ๆ การเปลี่ยนจากอักษรเป็นกราฟฟิกจะไม่สามารถทํา
เป็นอักษรได้หรือพิมพ์เพ่ิมเติมได้อีก  เพราะฉะน้ันการทํางานจึงต้องพิจารณาให้ดีก่อนคําสั่งเปลี่ยน
อักษรเป็นกราฟฟิกคือ Create Outlines 
Select: เป็นหมวดของคําสั่งท่ีใช้ในการเลือกวัตถุ สามารถเลือกด้วยคุณสมบัติได้ เช่น เลือกวัตถุท่ีมี 
Fill และStroke แบบเดียวกัน วัตถุท่ีอยู่บน Layer เดียวกัน เป็นต้น 
Filter: เป็นหมวดของคําสั่งท่ีใช้สร้างเทคนิคพิเศษให้กับภาพ โดยจะมีผลต่อรูปร่างของ Path 
Effect: เป็นหมวดของคําสั่งท่ีใช้สร้างเทคนิคพิเศษให้กับภาพคล้าย Filter แต่จะไม่มีผลกับรูปร่างของ
Path โดยภาพรวมแล้วคําสั่งนี้จะช่วยในการสร้างวัตถุให้มีความซับซ้อนหรือต้องการกราฟฟิก
สําเร็จรูปเพ่ิมเติมให้กับวัตถุท่ีเราสร้างได้เหมือนกับวัตถุช้ินอ่ืนๆ ท่ีต้องการความเหมือนกัน 
View: เป็นหมวดของคําสั่งเกี่ยวกับการมองทุกสิ่งในงาน เช่น Zoom Show/Hide Ruler Bounding 
BoxOutline Mode/Preview Mode เป็นต้น 
Window: เป็นหมวดของคําสั่งเกี่ยวกับการเปิด-ปิดหน้าต่างเคร่ืองมือต่างๆ เช่น Palette Tool Box 
เป็นต้น คําสั่งน้ีจะเป็นการช่วยเหลือการจัดการกับหน้าจอเพ่ิมเติมได้หรือสามารถแก้ไขพ้ืนที่ทํางาน
ของเราได้ตามต้องการ 
Help: เป็นหมวดที่รวบรวมวิธีการใช้งานและคําแนะนําเพ่ือช่วยเหลือผู้ใช้โปรแกรม แต่คอมพิวเตอร์
ของเราจะต้องเช่ือมต่อกับอินเตอร์เน็ตและมีซอฟต์แวร์ลิขสิทธ์ 



17 
 

 
 

ภาพท่ี 5  ภาพกล่องเครื่องมือ (Tool Box) 

 
กล่องเครื่องมือ (Tool Box) 
Tool Box  เป็นเครื่องมือพ้ืนฐานท่ีใช้ในการทํางานเก่ียวกับภาพท้ังหมด ซ่ึงจะแบ่งออกเป็นช่วง ๆ 
ตามกลุ่มการใช้งาน ดังนี้ 
1. กลุ่มเครื่องมือเกี่ยวกับการเลือกวัตถุ 
2. กลุ่มเครื่องมือเกี่ยวกับการวาดและการสร้างตัวหนังสือ 
3. กลุ่มเครื่องมือเกี่ยวกับการปรับแต่งวัตถุ 
4. กลุ่มเครื่องมือในการสร้าง Symbol และ Graph 
5. กลุ่มเครื่องมือเกี่ยวกับการกําหนดสี 
6. กลุ่มเครื่องมือเกี่ยวกับการตัดแบ่งวัตถุ 
7. กลุ่มเครื่องมือเกี่ยวกับพ้ืนท่ีทํางาน 
8. กรอบที่ใช้ระบุสีให้วัตถุและสีของเส้น 
9. ปุ่มกําหนดรูปแบบของมุมมองในหน้าจอโปรแกรม 
พ้ืนท่ีทํางาน (Art board Area) 

เป็นขอบเขตของพ้ืนท่ีการทํางาน ซ่ึงมีจุดท่ีต้องระวังคือ บริเวณที่อยู่ในเส้นประเป็นพ้ืนท่ีที่จะ
ถูกพิมพ์ออกมา และส่วนของภาพที่อยู่นอกเส้นนี้จะถูกตัดขาดไปเวลาพิมพ์ ในพ้ืนท่ีที่เราทํางาน
อาจจะมีช้ินงานมากมายหลายช้ินแต่เราก็สามารถเก็บไว้ได้โดยไม่ต้องลบทิ้งโดยเราจะอาศัยเลเยอร์
ช่วยในการเก็บช้ินส่วนหรือช้ินงานต่าง ๆ ได้การทํางานบนพ้ืนที่ทํางานสามารถขยายได้ 
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จานเคร่ืองมือต่างๆ (Palette) 
เปรียบเสมือนแผ่นหรือจานผสมสีของจิตรกร ท่ีเป็นแหล่งกําเนิดของเส้นสายหรือสีสันของ

ภาพ จานเครื่องมือต่าง ๆ เหล่าน้ีเป็นหน้าต่างขนาดเล็กท่ีรวบรวมคําสั่งและคุณสมบัติของเครื่องมือ
ต่าง ๆ ไว้เป็นหมวดหมู่การเรียกใช้ Palette ให้คลิกที่เมนู Window จะเห็นรายช่ือ Palette ต่าง ๆ 
ให้เลือกตามต้องการ ซ่ึง Palette ที่ใช้บ่อย ๆ มีดังน้ี 
1. Palette ท่ีเก่ียวข้องกับการใช้สีและเส้น 

 
 

ภาพท่ี 6  Palette ในการใส่สี 
 

Color Palette: เหมือนจานสีที่ใช้ผสมสีไว้ใช้เอง โดยระบุค่าสีหรือสุ่มเลือกที่แถบสีด้านล่างก็ได้เพ่ือให้ 
ได้สีใหม่ไม่จํากัดอยู่แต่สีที่ผสมไว้ให้ใน Swatch 

 
 

ภาพที่ 7  Color Paletteเป็นท่ีรวบรวมสี 
 

Swatch Palette เหมือนกล่องเก็บสีท่ีผสมสําเร็จรูปไว้ใช้ได้ทันที ทําให้ไม่ต้องผสมใหม่ทุกครั้งท่ีจะใส่
สีโดยสามารถเก็บสีท่ีมีลักษณะเป็นกราฟฟิกประเภทลวดลายแบบเวกเตอร์ได้เช่นกัน 
 

 
 

ภาพท่ี 8  Gradient Paletteใช้สําหรับไล่โทนสี 
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Gradient Palette  ใช้กําหนดค่าการไล่โทนสีให้วัตถุ ท้ังการกําหนดรูปแบบการไล่สีระหว่างแบบ
เส้นตรงหรือรัศมี และปรับแต่งโทนโดยใช้แทบ Gradient Bar ด้านล่างทําให้รูปมีมิติและความลึกมาก
ขึ้น 

 
 

ภาพท่ี 9  Stroke Paletteใช้ในการลงสีเส้น 
 

Stroke Palette ใช้กําหนดคุณสมบัติต่าง ๆ เช่นขนาดของเส้น รูปแบบของรอยต่อหรือปลายเส้น 
ฯลฯ 

 
 

ภาพที่ 10  Brushes Palette ใช้ทําเป็นพู่กันระบายสี 
 

Brushes Palette บรรจุชนิดของหัวพู่กันสําเร็จรูปไว้ให้เลือกใช้ โดยสามารถเลือกกําหนดคุณสมบัติ
ของหัวพู่กันได้ด้วย ทําให้เส้นสายพลิ้วพราย มีลูกเล่นไม่ธรรมดาเหมือนกับได้ใช้พู่กันจริงๆ ระบายสี 
2. Palette ท่ีเก่ียวข้องกับการปรับแต่งและจัดการวัตถุ 

 
 

ภาพท่ี 11  Transform Paletteใช้ในการปรับขนาดชิ้นงาน 
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Transform Palette ใช้กําหนดตําแหน่ง ขนาดและปรับแต่งรูปร่างของวัตถ ุโดยการระบุค่าเป็น
ตัวเลข เพ่ือให้ได้ระยะที่ถูกต้องและแม่นยํา 

 
 

ภาพท่ี 12  Align Paletteใช้จัดเรียงช้ินงาน 
 

Align Palette: ใช้ควบคุมการจัดเรียงวัตถุ ไม่ว่าจะเป็นการจัดแนวของวัตถุให้ตรงกันในแนวต่าง ๆ 
หรือการจัดระยะห่างระหว่างวัตถุ โดยคลิกเลือกวัตถุก่อนแล้วเลือกวิธีการจัดเรียงที่ต้องการ ช่วยให้
งานมีระเบียบเรียบร้อยสวยงาม 

 
 

ภาพท่ี 13  Pathfinder Palette ใช้ในการรวมหรือตัดช้ินงาน 

 
Pathfinder Palette: ใช้สร้างวัตถุใหม่ จากการรวมรูปร่างของวัตถุเดิมเข้าด้วยกัน ช่วยในการสร้าง
วัตถุ โดยไม่จําเป็นต้องเริ่มวาดเองใหม่ท้ังหมดใช้ร่วมกันให้เกิดเป็นรูปร่างใหม่ได้สะดวกและรวดเร็ว ใน
การใช้เคร่ืองมือ Pathfinde จะช่วยในการรวมลวดลายให้เป็นช้ินเดียวได้เป็นอย่างดี  ผู้วิจัยได้ใช้
เครื่องมือชนิดนใีนการรวมรายหรือตัดลายได้เพราะเราสามารถกําหนดส่วนท่ีทับกันให้กดทับส่วนท่ีอยู่
ด้านล่าง  เหมือนกับเราใช้ลวดลายด้านบนเป็นใบมีดตัดทับลวดลายด้านบน ในการกําหนดหรือรวม
ลวดลายจะต้องพิจารณาให้รอบครอบก่อนเพราะหากว่าเรารวมหรือตัดลายแล้วจะไม้สามารถกลับมา
แก้ไขให้เป็นแบบเดิมได้อีก  นอกจากจะใช้เครื่องมือundo ที่เป็นเคร่ืองมือย้อนกลับของโปรแกรม
ท่ัวไปซ่ึงก็ไม่สะดวกนัก  อย่างไรก็ดีการเขียนลายโดยใช้เครื่องมือPathfinde จะมีส่วนทําให้งานเรา
สมบูรณ์มากขึ้นและท่ีสําคัญสามารถทํางานได้รวดเร็วมากขึ้นอีกหลายเท่า 
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3. Palette ท่ีเก่ียวข้องกับการใช้งานตัวหนังสือ 

 
 

ภาพท่ี 14  Character Paletteใช้ปรับแก้ไขตัวหนังสือ 
 

Character Palette: ใช้กําหนดรูปแบบตัวหนังสือ โดยกําหนดได้ละเอียดมาก ทั้งชนิด ขนาด ความสูง 
ความกว้าง ตัวยก ตัวห้อย ฯลฯ เพ่ือทําให้ตัวอักษรดูหลากหลายและมีลูกเล่นต่าง ๆ 
 

 
 

ภาพท่ี 15  Paragraph Paletteใช้ในการจัดเรียงข้อความ 
 

Paragraph Palette: ใช้กําหนดรูปแบบการจัดเรียงข้อความ โดยกําหนดได้ละเอียดมาก ท้ังการจัดชิด
ซ้าย ขวา กลาง ฯลฯ ตลอดจนระยะย่อหน้าต่างๆ ซ่ึงสามารถระบุค่าเป็นตัวเลขได้ เพ่ือทําให้ข้อความ
เป็นระเบียบเรียบร้อยสวยงาม 
4. Palette ท่ีเก่ียวข้องกับการควบคุมและการจัดการในหน้ากระดาษ 

 
 

ภาพท่ี 16  Layers Paletteใช้สร้างช้ันของพื้นท่ีทํางาน 
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Layers Palette ใช้จัดการวัตถุท่ีบรรจุอยู่ในแต่ละเลเยอร์ ซ่ึงทํางานเหมือนเป็นแผ่นใสท่ีซ้อนกันเป็น
ช้ัน ๆ ใช้ควบคุมทั้งการมองเห็น การล็อควัตถุการจัดลําดับซ้อนทับกัน ฯลฯ 
 

 
 

ภาพท่ี 17  Links Paletteใช้เช่ือมโยงไฟล์ 

Links Palette ใช้ควบคุมการเช่ือมต่อข้อมูลกับภาพต้นฉบับที่นําเข้ามาใช้โดยสามารถเลือก ให้ไฟล์
ภาพท่ีนําเข้ามาลิงค์อยู่หรือฝังอยู่ในไฟล์ก็ได้ส่วนใหญ่มักจะเลือกลิงค์ภาพเพ่ือไม่ให้ไฟล์งานมีขนาด
ใหญ่เกินไป 
5. Palette ท่ีเก่ียวข้องกับการใส่ลูกเล่นหรือเอฟเฟ็กต์ให้วัตถุ 

 
 

ภาพท่ี 18  Transparency Palette ใช้กําหนดความโปร่งใสโดยคิดเป็นเปอร์เซ็นต์ 
 

Transparency Palette: ใช้กําหนดค่าความโปร่งแสงของวัตถุ โดยคลิกเลือกรูปแบบของ Blending 
Mode ท่ีต้องการและกําหนดค่าความทึบที่ช่องOpacity เพ่ือทําให้ภาพมีลูกเล่นแปลก ๆ โดยสัมพันธ์
กับวัตถุอ่ืน ๆ ท่ีซ้อนกันอยู่ด้านล่าง 

 
ภาพท่ี 19  Graphic Styles Palette กําหนดรูปแบบกราฟฟิกสําเร็จรูป 
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Graphic Styles Palette: ใช้กําหนดสี เส้น และเอฟเฟ็กต์ต่าง ๆ แบบสําเร็จรูป โดยคลิกเลือกวัตถุ
แล้วคลิกเลือกไอคอนสไตล์ท่ีต้องการ ช่วยให้ทํางานได้เร็วขึ้น เพราะเป็นการเก็บคุณสมบัติไว้ใช้กับ
วัตถุอ่ืน ๆ ได้โดยไม่ต้องกําหนดใหม่ทีละอัน ๆ 

 
 

ภาพท่ี 20  Symbols Palette กราฟฟิกสัญลักษณ์สําเร็จรูป 
 

Symbols Palette: บรรจุชนิดของวัตถุสําเร็จรูปให้ใช้ซํ้า โดยใช้ร่วมกับเครื่องมือในกลุ่ม
Symbolism Tool เป็นการเอาวัตถุเดียวมาใช้ซํ้าไปซํ้ามาในงาน จึงมีข้อมูลเพียงอันเดียวของวัตถุ
สําเร็จรูปน้ัน ช่วยลดขนาดของไฟล์ได้มาก โดยเฉพาะอย่างย่ิงเม่ือนําไปใช้ในงานที่เกี่ยวกับเว็บไซด์ 
2 Drawing Paths การวาดภาพโดยใช้รูปทรงสําเร็จ 

รูปเลขาคณิตและรูปร่างท่ีใช้กันบ่อย ๆ ได้แก่ สี่เหลี่ยมจัตุรัสสี่เหลี่ยมผืนผ้า สี่เหลี่ยมมุมมน 
สามเหลี่ยม วงกลม วงรี รูปหลายเหลี่ยมรูปดาว ฯลฯ ซ่ึงสามารถสร้างได้ง่าย ๆ ด้วยเครื่องมือในกลุ่ม 
Shape Tool ซ่ึงมีท้ังหมด 6 ชนิดคือ 

 
 

    ภาพท่ี 21  Drawing Paths ชุดวาดรูปทรงสําเร็จรูป 
 

 
 

ภาพท่ี 22  ภาพขยายชุดวาดรูปทรงสําเร็จรูป 
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1. Rectangle Tool ใช้สร้างสี่เหลี่ยมท้ังจัตุรัสและผืนผ้า 
2. Rounded Rectangle Tool ใช้สร้างสี่เหลี่ยมทั้งจัตุรัสและผืนผ้าท่ีมีมุมโค้งมน 
3. Ellipse Tool ใช้สร้างวงกลมและวงรี 
4. Polygon Tool ใช้สร้างรูปหลายเหลี่ยม เช่น สามเหลี่ยม ห้าเหลี่ยม หกเหลี่ยม ฯลฯ 
5. Star Tool ใช้สร้างรูปดาว รูปหลายแฉก 
6. Flare Tool ใช้สร้างรูปประกายรัศมี 
เครื่องมือที่ช่วยในการวาดรูปร่างพ้ืนฐาน มีหลักการใช้อยู่ 2 แบบ เช่นเดียวกับ Line Tool คือ 
1. วาดอิสระตามการแดรกเมาส์ (Freehand) 
2. วาดโดยการระบุค่าต่าง ๆ ให้โปรแกรมคํานวณออกมาเป็นภาพ (Properties Specification) 
การอธิบายเคร่ืองมือจะอยู่บนพ้ืนฐานการวาดท้ัง 2 แบบนี้ จะเลือกใช้วิธีการใดก็ขึ้นกับความต้องการ 
และความถนัดของผู้ใช้ โดยมากการวาดแบบที่ 2 มักใช้เม่ือต้องการงานท่ีแม่นยํา เช่น งานอาร์ตเวิร์ก 
เป็นต้น 
การวาดส่ีเหล่ียม วงกลมและวงรี 
เครื่องมือที่ใช้ในการวาดสี่เหลี่ยม วงกลม และวงรี มีหลักการใช้งานคล้ายคลึงโดยมีข้อแตกต่างกันคือ
การกดShiftในระหว่างลากเมาท์ก็จะได้วงกลมหากไม่ได้กดShift ก็จะได้วงรีตามท่ีเราทําการลากเมาท์
ซ่ึงจะได้ขนาดตามระยะท่ีเราลาก 

 
 

ภาพท่ี 23  การวาดวงรี วงกลม 

วิธีการทํามีขั้นตอนดังนี้ 
1. คลิกเคร่ืองมือ รูปสี่เหลี่ยม สี่เหลี่ยมมุมมน หรือวงรี ตามต้องการ 
2. ถ้ายังไม่ได้เปิดหน้าต่าง Stroke Palette และ Swatch Palette ให้เปิด Palette ท้ังสองโดยไปที่ 
เมนู แล้วเลือก Window > Stroke (หรือกด F10 ) และ Window > Swatches 
3. เลือกขนาดของเส้นท่ี Stroke Palette ในช่อง Weight 
4. คลิกที่ Stroke Box คลิกเลือกสีท่ี Swatch Palette เป็นการกําหนดสีให้กับเส้น 
5. คลิกที่ Fill Box 
6. คลิกเลือกสีท่ี Swatch Palette เป็นการกําหนดสีให้กับวัตถุ 
7. แดรกเมาส์บน Art board จากมุมหนึ่งไปยังอีกมุมหนึ่ง 
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การวาดสามเหล่ียมและรูปหลายเหล่ียม 
เครื่องมือที่ใช้ในการวาดรูปสามาเหลี่ยมและรูปหลายเหลี่ยมคือ เคร่ืองมือ Polygon Tool 

 
 

ภาพท่ี 24  การวาดรูปแบบหลายเหล่ียม 

วิธีการทํามีขั้นตอนดังนี้ 
1. คลิกเคร่ืองมือ Polygon Tool 
2. เลือกขนาดของเส้นท่ี Stroke Palette ในช่อง Weight 
3. คลิกที่ Stroke Box 
4. คลิกเลือกสีท่ี Swatch Palette เป็นการกําหนดสีให้กับเส้น 
5. คลิกที่ Fill Box 
6. คลิกเลือกสท่ีี Swatch Palette เป็นการกําหนดสีให้กับวัตถุ 
7. เลื่อนเคอร์เซอร์ไปยังตําแหน่งท่ีต้องการให้เป็นศูนย์กลางของรูปหลายเหลี่ยม แล้วแดรก 
เมาส์จนได้รูปในขนาดที่ต้องการ โดยขณะท่ีแดรกให้ลองหมุนเคอร์เซอร์ไปมา จะเป็นการหมุนรูป
หลายเหลี่ยม 
8. กดคีย ์Shift ค้างขณะแดรกเมาส์จะเป็นการสร้างรูปหลายเหล่ียมที่ยืดออกในมุม 45องศาเสมอไม่
ว่าจะแดรกไปในทิศทางไหนก็ตาม 
9. กดปุ่มลูกศรข้ึน-ลงขณะแดรกเมาส์ จะเปน็การเพ่ิม-ลดจํานวนด้านของรูปหลายเหล่ียม โดยจํานวน
ด้านท่ีน้อยที่สุดคือ รูปสามเหลี่ยม และจํานวนด้านที่มากท่ีสุดก็จะได้รูปใกล้เคียงวงกลม 
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วิธีการวาดโดยการระบุค่าต่าง ๆ (Properties Specification) 
วิธีการทํามีขั้นตอนดังนี้ 

 
 

ภาพท่ี 25  กําหนดค่าการวาดรูป 

 
1. คลิกเลือกเครื่องมือ Polygon Tool 
2. คลิกบน Art board จะปรากฏหน้าต่าง Option ขึ้นมาให้เรากําหนดค่า 
3. ระบุค่าท่ีต้องการแล้วกดปุ่ม OK 
Radius คือรัศมีจากจุดศูนย์กลางไปยังจุดมุมของรูป ซ่ึงเท่ากับความยาวของเส้นในแต่ละด้าน 
Sides คือจํานวนด้านของรูปหลายเหลี่ยม 
การวาดรูปหลายแฉก (Star) 

การลากให้ทําการแดรกเมาส์ตามลูกศร 
ภาพท่ี 26  การวาดรูปดาว 

วิธีการทํามีขั้นตอนดังนี้ 
1. คลิกเคร่ืองมือ Star Tool 
2. ถ้ายังไม่ได้เปิดหน้าต่าง Stroke Palette และ Swatch Paletteให้เปิด Palette ท้ังสองโดยไปที่ 
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   เมนู แล้วคลิก Window > Stroke (หรือกด F10) และ Window > Swatches 
3. เลือกขนาดของเส้นท่ี Stroke Palette ในช่อง Weight 
4. คลิกที่ Stroke Box 
5. คลิกเลือกสีท่ี Swatch Palette เป็นการกําหนดสีให้กับเส้น 
6. คลิกที่ Fill Box 
7.คลิกเลือกสีที่ Swatch Palette เป็นการกําหนดสีให้กับวัตถุ 
8.เคลื่อนเคอร์เซอร์ไปยังตําแหน่งท่ีต้องการให้เป็นศูนย์กลางของรูปหลายแฉก แล้วแดรก เมาส์จนได้  
   รูปในขนาดที่ต้องการ โดยขณะที่แดรกให้ลองหมุนเคอร์เซอร์ไปมาจะเป็นการหมุนรูปหลายแฉก 
9.กดคีย์ Shift ข้างขณะแดรกเมาส์จะเป็นการสร้างรูปหลายแฉกท่ียืดออกในมุม 45องศาเสมอไม่ว่า 
   จะแดรกไปในทิศทางไหนก็ตาม 
10.กดปุ่มลูกศรขึ้น-ลงขณะแดรกเมาส์ จะเป็นการเพิ่ม-ลดจํานวนด้านของรูปหลายแฉก โดยจํานวน 
    ด้านที่น้อยที่สุดคือรูปสามเหลี่ยม 
วิธีการวาดดาวโดยการระบุค่าต่าง ๆ (Properties Specification) 
วิธีการทํามีขั้นตอนดังนี้ 

 
 

ภาพท่ี 27  หน้าต่างกําหนดค่าในการวาด 

1. คลิกเลือกเครื่องมือ Star Tool 
2. คลิกบน Art board หรือดับเบิลคลิกท่ีรูปเคร่ืองมือ จะปรากฏหน้าต่างขึ้นมาให้กรอกข้อมูล 
3. ระบุค่าท่ีต้องการ แล้วกดปุ่ม OK 

 
ภาพท่ี 28  หน้าต่างกําหนดมุมของการวาดดาว 
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Radius 1 คือระยะจากจุดศูนย์กลางไปยังจุดที่อยู่นอกสุด 
Radius 2 คือระยะจากจุดศูนย์ไปยังจุดที่อยู่ในสุด 
Points คือจํานวนแฉกของรูปหลายเหลี่ยม 
เส้น Path 

เส้นพาร์ต Path ถ้าเป็นในโปรแกรม 3 มิติจะเรียกว่าเส้น Curve เส้น Path เป็นเส้นที่
กําหนดให้รูปทรงของช้ินงานหรืออาจกล่าวว่าเป็นเส้นรอบรูปก็ได้หากไม่มี Path ก็ไม่มีภาพเป็นคํากล่าวท่ี

ไม่เกินจริงเลยสําหรับโปรแกรมน้ี เพราะ Path คือหัวใจของโปรแกรมสร้างภาพแบบเวกเตอร์แทบทุก
โปรแกรม ไม่ว่าจะเป็น Freehand Corel Draw แม้กระท่ัง Flashแต่ในขณะเดียวกัน เราอาจมีเส้น 
Path โดยไม่มีภาพได้ดังนั้นการสร้างเส้น Path จะมีผลต่อการได้รูปทรง  การสร้างลวดลายแกะสลักเส้น 
Path  นับได้ว่ามีส่วนท่ีสําคัญท่ีสุดสําหรับการสร้างลวดลายแกะสลัก โปรแกรมกราฟฟิกเกือบท้ังหมดล้วนแต่มีความ

จําเป็นต้องใช้เส้น Path เพ่ือกําหนดเส้นรอบรูปเช่นเดียวกับการออกแบบลวดลายแกะสลัก  ก็จะต้อง
กํากับโดยเส้น Pathหรือเส้นรอบรูปเพ่ือกําหนดรูปแบบเพื่อนําไปใช้ในการแกะสลักไม้ตามที่ผู้วิจัยจะ
ได้ทําการวาดเส้น Pathลวดลายแกะสลักในส่วนต่อไปเส้น Path ประกอบด้วยส่วนต่าง ๆ ดังน้ี 
 

 
 

ภาพท่ี 29  การวาดเส้นPath 

1. จุดปลายของ Path (End Point) หรือเรียกสั้น ๆ ว่า “จุดปลาย” เป็นจุดท่ีอยู่ปลายสุดของPath 
ท้ัง2 ด้าน คือ ท้ังจุดเร่ิมต้นและจุดสุดท้ายของ Path 
2. จุดยึด (Anchor Point) หรือเรียกกันว่า ” จุด Anchor” (แอง-เคอร์)เป็นจุดที่อยู่บนเส้นระหว่างจุด 
ปลายท้ังสองด้าน ใช้เพ่ือเปลี่ยนทิศทางของเส้น นึกภาพง่าย ๆ เหมือนกับการเดินสายไฟบนผนังซ่ึง
ต้องใช้หมุดยึดเม่ือต้องการเปลี่ยนทิศทางของสายไฟ 
3. เส้น (Segment) ไม่ว่าจะเป็นเส้นตรงหรือเส้นโค้ง เกิดจากการเช่ือมต่อกันของจุด 2 จุดไม่ว่าจะ
เป็นจุดปลายหรือจุด Anchor จํานวนของเส้นมีผลต่อความนุ่มนวลของ Path (ใช้ในการสร้างภาพ
แบบระบุค่า ซ่ึงจะกล่าวถึงภายหลัง) 
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4. แขนปรับทิศทาง (Direction Line) หรือเรียกสั้น ๆ ว่า “แขน” เป็นตัวช้ีบอกว่าเส้นจะโค้งไปทาง
ไหนและมีความโค้งมากน้อยเท่าไหร่ 
5. จุดปลายของแขนปรับทิศทาง (Direction Point) หรือเรียกสั้น ๆ ว่า “จุดปรับ” เป็นจุดที่อยู่ตรง 
ปลายแขนปรับทิศทาง ใช้เป็นตัวบังคับให้ “แขน” ช้ีไปในทิศทางที่ต้องการ 
รูปร่างของ Path ม ี2 ลักษณะใหญ ่ๆ คือ 

 
 

ภาพท่ี 30  การวาดเส้นPathแบบเปิดและปิด 
 

1. Path ท่ีเป็นรูปเปิด คือรูปร่างท่ีมีจุดปลายของ Path เป็นคนละจุดแยกจากกัน 
2. Path ท่ีเป็นรูปปิด คือรูปร่างท่ีมีจุดปลายของ Path มาบรรจบกันและเป็นจุดเดียวกัน 
Anchor และแขน (Direction Line)  

จุด Anchor และแขนเป็นตัวกําหนดรูปร่างของ Path ว่า Path น้ันจะไปในทิศทางไหน เป็น
เส้นตรงหรือเส้นโค้ง โค้งมากหรือโค้งน้อย ในการวาด Path เราจะใส่จุด Anchor ในตําแหน่งที่
ต้องการเปลี่ยนทิศทางของเส้น หรือต้องการดัดเส้นให้โค้ง แล้วลากแขนไปในทิศทางที่เราต้องการให้
โค้งไปทางนั้นจุด Anchor บน Path มี 2 ชนิดคือ จุด Anchor ท่ีเป็นมุม (Comer Point) และจุด 
Anchor ที่เป็นรอยต่อของเส้นโค้ง (Smooth Point) ในการวาด Path ต้องเลือกใช้ Anchor ให้ถูก
ชนิดมาผสมกันจึงจะได้เสน้ท่ีต้องการ ดังภาพด้านล่างนี้ 

 
 

ภาพท่ี 31   สามข้ันตอนการวาดเส้นPath 
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1 คือจุด Anchor ท่ีไม่มีแขน ทําให้เกิดเส้นตรงหักมุมต่อกัน 
2 คือจุด Anchor ท่ีมีแขน 1 ข้าง ทําให้เกิดเส้นโค้งและเส้นตรงต่อกัน 
3 คือจุด Anchor ท่ีมีแขน 2 ข้าง ทําให้เกิดเส้นโค้ง 2 เส้นต่อกัน 

   การวาดโดยใช้ Pen tool เป็นเคร่ืองมือวาดภาพท่ีใช้ในการวาดเส้นโดยให้ความสะดวกใน
การวาดหรือการขึ้นรูปซ่ึงในโปรแกรมกราฟฟิกต่างๆก็ล้วนแต่มีเครื่องมือPen toolด้วยกัน  อย่างไรก็
ดีการใช้เครื่องมือชนิดน้ีมีลักษณะที่คล้ายกันมาก  ซ่ึงผู้วิจัยได้ทําการใช้เคร่ืองมือชนิดน้ีในโปรแกรม
ต่าง ๆ ซ่ึงให้ผลดีต่อการทํางานท่ีเป็นงานลายเส้นโดยเฉพาะกับลวดลายแกะสลัก  ท่ีถือได้ว่าเป็นการ
ใช้เครื่องมือPen toolในการทํางานลายเส้น 
Pen tool เป็นเครื่องมือที่ใช้ในการวาดเส้นและรูป สามารถวาดได้ท้ังเส้นตรงเส้นโค้ง 
            

 
 

ภาพท่ี 32  ลักษณะการวาดเส้นPathท่ีเป็นเส้นโค้ง 
 

วิธีการใช้งาน 
1. เส้นเฉียง ใช้เครื่องมือ Pen Click บนกระดาษตามแนวที่ต้องการได้เลย 
2. เส้นตรง ให้กดปุ่ม Shift ค้างไว้ แล้วใช้เครื่องมือ Pen Click บนกระดาษ เส้นที่ได้จะเป็นเส้นตรง  
   แนวต้ัง แนวนอน และเฉียง 45 องศา 
3. เส้นโค้ง ใช้เครื่องมือ  Pen Drag บนกระดาษจะมีแขนเกิดขึ้นตรงจุดที่  Drag จากน้ันให้ Drag จุด 
   ต่อไปน้ีจะมีเส้นโค้งเกิดขึ้นระหว่างจุดแรกกับจุดที่สองเม่ือ Drag จุดต่อไปจะมีเส้นโค้งเกิดขึ้น 
   ระหว่างจุดที่ Drag จะเป็นอย่างนี้เร่ือยไป 
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การเลือกวัตถุโดยใช้ Selection Tools 
Direct Selection เป็นเครื่องมือที่ใช้ในการเลือกวัตถุที่จะทํางานด้วย โดยวัตถุนั้นจะมี

สถานะเป็นUngroup ช่ัวคราว การใช้เครื่องมือชนิดนี้เพ่ือแก้ไขรูปทรงของรูป 

 
 

ภาพท่ี 33  เคร่ืองมือ Direct Selection  

 
วิธีการใช้งาน 
1.เป็นการเลือกแก้ไขจากจุด Anchor โดยตรงเม่ือแดรกเมาส์ไปท่ีจุดแล้วเลื่อนจะเห็นว่าจุดจะถูกย้าย
ตําแหน่งไปตามเมาส์และเส้นที่เช่ือมกับจุดนั้นก็เลื่อนตามไปด้วย 
2.เป็นการเลือกแก้ไขจากจุด Direction Point น้ันจะสังเกตได้ว่าจุด Anchor ไม่ได้เลื่อนไปไหน จะ
เลื่อนไปก็เฉพาะแขนทั้งสองด้านเท่านั้น 
3.เราสามารถแก้ไขโดยตรงจากเส้น Segment ได้ด้วยจากรูปจะเห็นว่ามีการยืดออกของเส้น 
Segmentและ แขน Direction Point แต่จุด Anchor ที่ยึดอยู่ทั้งสองข้างไม่มีการเปลี่ยนแปลง 
Group Selection เป็นเคร่ืองมือที่ใช้ในการเคล่ือนย้าย Object ออกจากกลุ่มงานท่ีใช้คําสั่ง Group 
โดยช่ัวคราว ( ขณะท่ีอยู่ใน View ท่ีเป็น Art work) 

วิธีการใชง้าน 

 
 

ภาพท่ี 34  เคร่ืองมือ Direct Selection เคล่ือนย้ายช้ินงานออกจากกลุ่ม 
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ขณะที่เป็น View-Art work ใช้เครื่องมือนี้ Drag Object ท่ีต้องการแยกออกจากกลุ่มช่ัวคราวจะเห็น
ได้ว่ารูปที่ Drag เท่านั้นท่ี Active ส่วนรูปอ่ืน ๆ จะไม่ Active  

 Add Anchor Point เป็นเครื่องมือท่ีถูกใช้ในการเพ่ิมจุดบนเส้น เพ่ือใช้งานกับจุดนั้น 

               

ภาพท่ี 35  เครื่องมือ Add Anchor ในการดัดเส้น 
 

วิธีการใชง้าน นําเครื่องมือ Add Anchor Point มา Click บนเส้นก็จะเกิดจุดขึ้นตามที่ต้องการ 
 Delete Anchor Point เป็นเครื่องมือท่ีใช้ในการลบจุดที่ไม่ต้องการออก 

                  
 

ภาพท่ี 36  เครื่องมือ Add Anchor ในการลบจัดตัดบนเส้น 
 

วิธีการใช้งาน นําเคร่ืองมือ Delete Anchor Point มา Click ท่ีจุดที่ต้องการลบ จุดก็จะหายไป 
 Convert Direction Point เป็นเคร่ืองมือในการเพ่ิมแขน หรือหักแขนของจุด 

 
 

ภาพท่ี 37  เครื่องมือ Add Anchor ในการเปล่ียนจุดตัดเส้นตรงเป็นเส้นโค้ง 
วิธีการใช้งาน 
1.เพ่ิมแขนใช้ Selection Tool Click รูปที่ต้องการจะเพ่ิมแขน หลังจากน้ันใช้เครื่องมือConvert 
DirectionPoint Drag ท่ีจุด Anchor เพ่ือเพ่ิมแขนให้กับจุดนั้น 
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2.หักแขนใช้ Selection Tool Click รูปที่ต้องการจะหักแขน หลังจากน้ันใช้เครื่องมือ Convert 
DirectionPoint Drag ท่ีจุดปลายแขนเพ่ือหักแขนให้กับจุดน้ัน 
 
Painting Objects 

ระบบสีในโปรแกรม Illustrator (Color Mode)หลายๆคนคงจะสงสัยว่าจะทํางานท่ีทําอยู่ใน
ระบบสีอะไรดี ทําไมต้องเลือกต้ังแต่แรกเวลาสั่ง NewFile ด้วย น่ันเพราะการกําหนดสีให้กับไฟล์มีผล
ต่อสีของภาพท่ีปรากฏเม่ือเรานําไฟล์ไปใช้ โหมดสีในIllustrator มี 5 โหมดสีคือ Grayscale RGB 
HSB CMYK และ Web Safe RGB 

 
 

ภาพท่ี 38 Grayscale Mode 

Grayscale Modeเป็นโหมดสีของภาพขาวดํา คือมีแต่สีดําโทนต่างๆ ไล่ต้ังแต่ไม่มีสี (คือสีขาว) สีเทา
ไปจนถึงดํา 

 
 

ภาพท่ี 39 RGB Mode 

RGB Modeระบบสี RGB เป็นระบบสีของแสง (Red Green Blue) ได้แก่ สีบนหน้าจอคอมพิวเตอร์
และสีในโทรทัศน์ 
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ภาพท่ี 40 HSB Mode 

 
HSB Modeคือหลักการมองเห็นสีตามสายตามนุษย์ ประกอบด้วย Hue SaturationBrightness 
 

 
 

ภาพท่ี 41 CMYK Mode 
 

เป็นระบบสีทางการพิมพ์ระบบออฟเซต ที่ใช้หลักการผสมสี 4 ชนิดคือ Cyan สี 
ฟ้า Magenta สีม่วงแดง Yellow สีเหลือง และ Black สีดํา 
 

 
 

ภาพท่ี 42  Web Safe RGB 

Web Safe RGBเป็นภาพโหมด RGB ท่ีลดทอนจํานวนสีลง และระบุเป็น Code ของค่าสีเพ่ือใช้บน
เว็บไซด์ 
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องค์ประกอบพ้ืนฐานที่ใช้ในการระบุสีและเลือกสี 
เม่ือเราเลือกโหมดสีให้กับไฟล์แล้ว ก็มารู้จักวิธีการใส่สีกัน การระบุสีให้กับวัตถุสิ่งที่ต้องรู้เป็นพ้ืนฐานก็
คือ 
1. หน้าต่าง Fill Box และ Stroke Box ใน Tool Box 
2. Color Palette 
3. Stroke Palette 
หน้าต่าง Fill Box และ Stroke Box ใน Tool Box 

 
 

ภาพที่ 43 Fill Box และ Stroke Box 

 
1. Fill Box เป็นกรอบที่บอกสีของวัตถุ 
2. Stroke Box เป็นกรอบที่บอกสีของเส้น 
3. Swap Fill and Stroke 
4. Default Fill and Stroke 
5. Color คลิกเพ่ือเลือกใช้สีธรรมดา (Solid Color) 
6. Gradient คลิกเพ่ือเลือกใช้สีไล่โทน (Gradient Color) 
7. None คลิกเพ่ือไม่ใช้สีใดๆ (โปร่งใส) 
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วิธีการใส่สีให้กับวัตถุ 
1. คลิกเลือกวัตถุท่ีจะใส่สี 

 
 

ภาพท่ี 44 เส้นวัตถ ุ
 

2. คลิกเลือกวัตถุท่ีจะใส่สี 

 
 

ภาพท่ี 45 Color Picker 
 

3. ดับเบิลคลิกที่ช่อง Fill Box เพ่ือเลือกสีให้วัตถุ จะปรากฏหน้าต่าง Color Picker ขึ้นมา เลือกสีท่ี 
ต้องการแล้วคลิกปุ่ม OK 
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4. คลิกที่ปุ่ม Swap Fill and Stroke เพ่ือสลับสีระหว่างสี Fill และ Stroke จะเห็นสีของวัตถุและ
เส้นสลับกัน 

 
 

ภาพท่ี 46 Swap Fill and Stroke 

 
5. คลิกที่ปุ่ม None จะเป็นการยกเลิกสีใช้ได้ทั้ง Fill Box และ Stroke Box 

 
 

ภาพท่ี 47 None Fill Box  

 
6. คลิกที่ปุ่ม Gradient จะเป็นการใส่สีแบบไล่โทนให้แก่วัตถุท่ีถูกเลือก (ใช้ได้เฉพาะกับสีพ้ืน ไม่ 
สามารถใช้กับสีของเส้นได้) 

 
 

ภาพท่ี 48 Gradientขาว ดํา 
 

7. คลิกที่ปุ่ม Default Fill and Stroke เป็นการทําให้สีกลบัไปเหมือนค่าเริ่มต้นคือขาวดํา 

 
 

ภาพท่ี 49 Fillขาว Strokeดํา 
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การกําหนดคุณสมบัติของเส้นด้วย Stroke Palette 

 
 

ภาพท่ี 50 Stroke Palette 
 

เม่ือวาดเส้นเสร็จแล้ว ถ้าอยากได้เส้นชนิดอ่ืน เช่น เส้นประ เส้นปลายมน ฯลฯ ทําโดย
กําหนดขนาดและรูปแบบของเส้นได้ใน Stroke Palette โดยวิธีการทํามีขั้นตอนดังนี้ 
1. คลิกเลือกเครื่องมือลูกศรสีดํา เพ่ือใช้เลือกวัตถุ 
2. คลิกที่เส้นบนArt broad เป็นการเลือกเส้น 

Weight: ใส่ตัวเลขหรือคลิกท่ีสามเหลี่ยมเพ่ือกําหนดความหนาของเส้นMiter Limit: ใส่
ตัวเลขเพ่ือปรับความแหลมของมุมรอยต่อของเส้น โดยการกําหนดให้เป็นตัวคูณของความหนาของ
เส้น (Weight) ค่าปกติจะอยู่ท่ี 4 ถ้าเส้นหนาข้ึนต้องกําหนดค่า Miter ให้มากขึ้นมุมจึงจะแหลมCap: 
คลิกเลือกรูปแบบของปลายเส้น ให้เป็นปลายตัดตรงพอดีกับจุดปลาย ปลายมนหรือปลายตัดที่ย่ืนเกิน
จุดปลาย ตามลําดับJoin: คลิกเลือกรูปแบบของรอยต่อของเส้นให้เป็นมุมแหลม มุมมน หรือมุมตัด 
ตามลําดับ 

 
 

ภาพท่ี 51 Join 

 
เปรียบเทียบเส้นที่ใช้ Join ชนิดต่างๆ 
Dashed Line: คือ เส้นประให้คลิกที่ช่องสี่เหลี่ยมหน้าคําว่า Dashed Line เพ่ือเลือก 
a. Dash ความยาวของเส้นประ 
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b. Gap ระยะห่างระหว่างเสน้ประ 

 
 

ภาพท่ี 52 Cap หรือช่องว่างระหว่างเส้นประ 
 

เปรียบเทียบการกําหนด Cap ชนิดต่างๆ 
Swatch Palette 

 
 

ภาพท่ี 53 หน้าต่าง Swatch Palette 
 

เปรียบเหมือนสีท่ีผสมสําเร็จเก็บเป็นชุดๆ ไว้ใช้ซํ้า ทําให้ไม่ต้องระบุค่าสใีน Color Palette ทุกครั้ง 

Painting Tools 
การใส่สีโดยใช้เครื่องมือช่วยการใส่สีด้วย Eyedropper 

 
 

ภาพที่ 54 Eyedropper 
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มีหลักการใช้คล้ายกับ Paint Bucket แต่เป็นการดูดค่าทั้งหมดจากวัตถุอ่ืนมาใช้กับวัตถุท่ีถูกเลือกไม่ 
ว่าจะเป็นค่าสีของ Fill และ Stroke ขนาดของเส้น ชนิดของ Brush รวมทั้ง Style ด้วย 
Paint Bucket 

 
 

ภาพท่ี 55 Paint Bucket 

 
เป็นการใส่สีของท้ังค่าสีของ Fill และ Stroke ขนาดของเส้น ชนิดของ Brush รวมท้ัง Style ด้วยแต่ 
ไม่ดูดค่าจากวัตถุอ่ืนได้เหมือน Eyedropper ต้องค่าสีเอาเอง 
วิธีการใช้ Brush 
การใช้ Brush ทําได้ 2 วิธีคือ 
วิธีท่ี 1 วาดใหม่ด้วยเครื่องมือ Paintbrush Tool 
 

 
 

ภาพท่ี 56 Brush 

1.เลือกเครื่องมือ Paintbrush Tool 
2. หากยังไม่ได้เปิด Brush Paletteให้เปิดโดยไปที่เมนู Window > Brushes หรือกด F5 แล้วเลือก 
ชนิดของหัวพู่กันท่ีต้องการ 
3. แดรกบน Art board จากตําแหน่งท่ีจะให้เป็นจุดเริ่มต้น ไปยังตําแหน่งที่จะให้เป็นปลายของเส้น 
วิธีท่ี 2 กําหนดชนิดของ Brush ให้กับเส้น Path ท่ีวาดไว้แล้ว 
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ภาพท่ี 57 กําหนดชนิดของ Brush 

1.คลิกเลือกลูกศรสีดํา เพ่ือใช้เลือกวัตถุ 
2. คลิกเลือกเส้น Path บน Art board 
3. หากยังไม่ได้เปิด Brush Palette ให้เปิดโดยไปที่เมนู Window > Brushes หรือกด F5 แล้วเลือก 
ชนิดของหัวพู่กันท่ีต้องการใน Brush Palette 
Brush ใหม่ไว้ใช้เอง 
หากดูใน Libraries แล้วยังไม่ถูกใจ เราสามารถท่ีจะสร้างหัวพู่กันไว้ใช้เอง โดยการสร้างชนิดของ 
Brush ใหม่เพ่ือเก็บไว้ใช้ได้ โดยทําดังนี้ 
1. จะเป็นเส้นหรือรูปปิดก็ได้วาดรูปบน Art board 

 
ภาพท่ี 58 สร้าง Brushใหม ่

2.ท่ีBrush Palette ให้กดปุ่ม New เพ่ือกําหนดให้รูปท่ีสร้างเป็น Brush ชนิดหนึ่งจะปรากฏ 
หน้าต่างให้เลือกประเภทของ Brush เป็น New Art Brushให้เลือกแล้วคลิก OK 

 
 

ภาพท่ี 59 New Art Brush 
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3.จะปรากฏหน้าต่างคุณสมบัติของ Brush ให้ระบุค่าต่าง ๆ ซ่ึงจะเป็นหน้าต่างตามประเภทของ 
Brush ท่ีเลือกไว้ ให้กําหนดคุณสมบัติและต้ังช่ือ แล้วคลิก OK จะเห็นไอคอนใหม่ใน Brush 
Palette เป็นรูปท่ีสร้าง 
 

 
 

ภาพท่ี 60 ไอคอนใหม่ใน BrushPalette 

Types 
เครื่องมือท่ีใช้ในการสร้างข้อความและทิศทางการเรียงตัวของตัวหนังสือ 

 
 

ภาพท่ี 61 Types 

 
ในโปรแกรม Illustrator มีเครื่องมือท่ีใช้ในการสร้างข้อความอยู่หลายตัว รองรับการทํางานท้ังแบบ 
ข้อความปกติ การสร้างลูกเล่นต่าง ๆ และการใช้งานข้อความยาว ๆ ซ่ึงมีท้ังหมด 6 ชนิดด้วยกันคือ 
1.  Type Tool ใช้สร้างข้อความปกติ 
 

 
 

ภาพท่ี 62 Type Tool 
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2. Area Type Tool ใช้สร้างจ้อความภายในขอบเขตท่ีกําหนด 

 
 

ภาพท่ี 63 Area Type Tool 
 

3. Path Type Tool ใช้ทําข้อความที่โค้งไปตามรูปร่างของ Path 

 
 

ภาพท่ี 64 Path Type Tool 
 

4. Vertical Type Toolใช้สร้างข้อความตามแนวต้ัง รองรับการใช้ภาษาจีนหรือญ่ีปุ่นได้ดี 

 
 

ภาพท่ี 65 Vertical Type Tool 
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5. Vertical Area Type Toolใช้สร้างข้อความตามแนวต้ังภายในขอบเขต 
ท่ีกําหนด 

 
 

ภาพท่ี 66 Vertical Area Type Tool 

6. Vertical Path Type Tool ใช้สร้างข้อความตามแนวต้ังท่ีโค้งไปตาม 
รูปร่างของ Path 

 
 

ภาพท่ี 67 Vertical Path Type Tool 
 

การจัดหน้ากระดาษและการกําหนด Paragraph 

 
 

ภาพท่ี 68 Paragraph 
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1. Align Left คลิกเพ่ือจัดหน้ากระดาษชิดซ้าย 
2. Alight Center คลิกเพ่ือจัดหน้าแบบยึดแกนกลางเป็นหลัก 
3. Alight Right คลิกเพ่ือจัดหน้ากระดาษชิดขวา 
4. Justify Full Lines คลิกเพ่ือจัดหน้าแบบตรงแนวด้านขวาให้เท่ากัน ทําให้เป็นระเบยีบด้วยการยึด
ระยะห่างของคํา (ช่องว่างที่กด spacebar) 
5. Justify All Lines คล้าย ๆ กับ Justify Full Lines แต่จะยึดระยะทุกบรรทัดรวมทั้งบรรทัด
สุดท้ายด้วย ซ่ึงอาจทําให้ระยะตัวอักษรเพียนเกินไปได้ 
6. Left Indent คือการกําหนดระยะที่ย่นเข้ามาทางด้านซ้าย 
7. First Line Left Indent คอืการกําหนดระยะย่อหน้าในบรรทัดแรก 
8. Right Indentคือการกําหนดระยะที่ย่นเข้ามาทางด้านขวา 
9. Space Before Paragraph คือการกําหนดระยะห่างระหว่าง Paragraph จะช่วยให้แบ่งข้อความ
แต่ละช่วงออกจากกันชัดเจนและอ่านง่ายขึน้ ระยะท่ีนิยมกําหนด ได้แก่ 6 pt. 12 pt. เป็นต้น 
 
การเปล่ียนรายละเอียดของตัวอักษร 

การเปลี่ยนรายละเอียดของตัวอักษรต่าง ๆ ของตัวอักษร ทําได้โดยใช้ Character Palette 
ซ่ึงสามารถเรียกใช้ได้โดยไปที่เมนู Window > Type > Character จะปรากฏหน้าต่าง Character 
Palette ซ่ึงสามารถเรียกดูOption เพ่ิมได้โดยคลิกท่ี แล้ว Show Option 

 
 

ภาพท่ี 69 Character 

 
วิธีการแก้ไขน้ันเราต้องทําการเลือกข้อความที่ต้องการก่อน จะใช้ลูกศรสีดําคลิกเลือกวัตถุท่ี

เป็นข้อความทั้งช้ิน หรือใช้ Type Tool แดรกให้เป็นแถบดําเฉพาะข้อความที่ต้องการแก้ไขก็ได้ เม่ือ



46 
 

เราเลือกข้อความเสร็จแล้ว ก็ระบุรายละเอียดใหม่ตามต้องการ โดยแต่ละรายการใน character 
Palette ใช้เปล่ียนรายละเอียดดังต่อไปนี้ 
1. Font Family คลิกเลือกชนิดของตัวอักษร 
2. Font Style คลิกเลือกลักษณะของตัวอักษร ได้แก่ ตัวปกติ ตัวเอียง ตัวหนา ตัวหนาและเอียง 
3. Font Size ใช้เปลี่ยนขนาดของตัวอักษร 
4. Leading ใช้ปรับระยะห่างระหว่างบรรทัด 
5. Kerning ใช้ปรับระยะห่างระหว่างตัวอักษร 2 ตัวท่ีอยู่ข้างกัน 
6. Tracking ใช้ปรับระยะห่างของตัวอักษรท้ังชุด 
7. Vertical Scale ใช้ปรับความสูงของตัวอักษร 
8. Horizontal ใช้ปรับความกว้างของตัวอักษร 
9. Baseline Shift ใช้ทําตัวยกหรือตัวห้อยเช่น 1010 H2O เป็นต้น 
10. Character Rotatetionใช้หมุนตัวอักษรตาองศาที่ต้องการ 
การเล่ือนตําแหน่งของข้อความบนเส้น Path 
1. ใช้ลูกศรสีดําคลิกที่ข้อความหน่ึงครั้ง จะเห็น I-beam ปรากฏข้ึนมา 

 
 

ภาพท่ี 70 ข้อความบนเส้น Path 

 
 
2. แดรกตรง I-beam เลื่อนไปมา จะเป็นการเปลี่ยนตําแหน่งของข้อความบน Path 
 

 
 

ภาพท่ี 71 การเปล่ียนตําแหน่งของข้อความบน Path 
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การพลิกตัวหนังสือบน Path 
1. ใช้ลูกศรสีดําคลิกที่ข้อความหน่ึงครั้ง จะเห็น I-beam ปรากฏข้ึนมา 

 
 

ภาพท่ี 72 การพลิกตัวหนังสือบน Path 
 

2. แดรกตรง I-beam เลื่อนกลับลงมาอีกด้านหน่ึง จะเป็นการพลิกกลับด้านของข้อความPath 

 
ภาพท่ี 73 การพลิกกลับด้านของข้อความPath 

 
 
การสร้างข้อความในกรอบส่ีเหล่ียม 

 
 

ภาพท่ี 74 การสร้างข้อความ 
 

1.คลิกเลือกเครื่องมือ Type Tool 
2. แดรกบน Art board จากจุดหนึ่งไปยังอีกจุดหน่ึง จะเห็นกรอบสี่เหลี่ยมดังรูป 
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ภาพท่ี 75 Type Tool 

 
3. พิมพ์ข้อความตามต้องการ โดยตัวหนังสือจะตัดขึ้นบรรทัดใหม่อัตโนมัติเม่ือสุดขอบของสี่เหลี่ยมแต่
หากข้อความยาวเกินกรอบที่วาดไว้ จะเห็นเป็นจุดสี่เหลี่ยมที่มุมขวาล่าง แสดงว่ายังมีข้อความต่อแต่ไม่
ปรากฏให้เห็น 
 

 
 

ภาพท่ี 76 ตัวหนังสือจะตัดขึ้นบรรทัดใหม่อัตโนมัติ 

 
การทําให้ตัวหนังสือกลายเป็น Path (Create Outline) 
1. ลือกวัตถุท่ีเป็นตัวหนังสือ 
2. เลือกเมนู Type > Create Outlines 

 
 

ภาพท่ี 77 Create Outline 
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Transformations 
ก่อนท่ีเราจะใช้ Transformation Tool นั้นเราควรท่ีจะรู้จักจุด Origin กันก่อนจุด Origin 

เป็นจุดที่ใช้เป็นหลักยึดวัตถุในการเปล่ียนแปลงแต่ละครั้งโดยเราสามารถย้ายจุด Origin ไปยังตําแหน่ง
ใดก็ได้ตัวอย่าง 

 
 

ภาพท่ี 78 Transformation Tool 

 
การปรับแต่งวัตถุ (Transforming)หรือการย่อขยายอิสระตามการแดรกเมาส์ 

 
 

ภาพท่ี 79 การปรับแต่งวัตถุ 

 
ทําได้โดยใช้เครื่องมือ Scale Tool หรือใช้ลูกศรสีดําแดรกท่ี Bounding Box 
1. การย่อขยายวัตถุท้ังช้ิน แบ่งเป็น 

1.1 การย่อขยายตามสัดส่วนเดิม ให้กดคีย์ Shift ค้างขณะแดรกNote กดคีย์ Alt ค้างขณะ
แดรกจะเป็นการย่อขยายโดยยึดจุดศูนย์กลางเป็นหลัก 

1.2 การย่อขยายเพียงด้านใดด้านหน่ึงคือ แนวนอน (Horizontal) หรือแนวต้ัง (Vertical) 
2. การย่อขยายเพียงบางส่วนของวัตถุ มีขั้นตอนการทําดังน้ี 

2.1 ใช้ลูกศรสีขาวเลือกเฉพาะจดุหรือเส้นท่ีต้องการย่อขยาย 
2.2 คลิกเลือกเคร่ืองมือ Scale Tool แล้วเลื่อนเคอเซอร์ไปยังตําแหน่งท่ีต้องการใช้เป็น

จุดอ้างอิงแล้วคลิก 
2.3 แดรกจุดที่เลือกไว้แล้วให้ได้ขนาดที่ต้องการ แล้วปล่อยปุ่มเมาส์ 
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การหมุนวัตถุ (Rotate) 

 
 

ภาพท่ี 80 การหมุนวัตถุ 

วิธีท่ี 1เป็นการหมุนอิสระตามการแดรกเมาส์ หลักการหมุนมี 3 รูปแบบ 
1. หมุนรอบจุดศูนย์กลาง สามารถใช้เครื่องมือลูกศรสีดําคลิกเลือกให้เห็น Bounding Box ได้ 

เลย โดยเลื่อนเคอเซอร์ไปอยู่ตรงมุมของวัตถุจะเห็นเคอเซอร์เป็นรูป    แล้วจึงแดรกเมาส์ 
เพ่ือหมุน 
2. หมุนโดยกําหนดจุดอ้างอิงใหม่ จะกําหนดไว้นอกวัตถุก็ได้ ทําได้โดย 
 2.1 ใช้ลูกศรสีดําเลือกวัตถุที่จุดหมุน 

 2.2 ใช้เครื่องมือ Rotate Tool  คลิกครั้งแรกเพ่ือกําหนดจุดอ้างอิง 
 2.3 แดรกเมาส์เพ่ือหมุนวัตถุ 
3. หมุนเพียงบางส่วนของวัตถุ ทําได้โดย 

3.1 ใช้ลูกศรสีขาวเลือกบางส่วนของวัตถุท่ีต้องการหมุน 
3.2 ใช้เครื่องมือ Rotate Tool คลิกครั้งแรกเพ่ือกําหนดจุดอ้างอิง 
3.3 แดรกเมาส์เพ่ือหมุนวัตถุ 

การพลิกวัตถุ (Reflect) 
วิธีท่ี 1 พลิกอิสระตามการแดรกเมาส์ 

เม่ือใช้ลูกศรสีดําคลิกเลือกวัตถุท่ีต้องการแล้ว ให้คลิกเลือกเคร่ืองมือ Reflect Tool แล้วทํา
ข้อใดข้อหน่ึงดังต่อไปน้ี 
1. คลิกครั้งแรกเพื่อกําหนดจุดอ้างอิง (Origin Point) คลิกอีกทีแล้วปล่อยเมาส์ วัตถุจะพลิกไปอยู่ 
ตรงข้ามแนวแกนที่เกิดจากการคลิกสองครั้ง 

 
 

ภาพท่ี 81 Reflect 
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2. แดรกวัตถุแทนการคลิก จนได้ตําแหน่งท่ีต้องการแล้วปล่อยเมาส์  จะเป็นการพลิกวัตถุไปพร้อม 
ๆ กับหมุนวัตถุพร้อมจุดที่เร่ิมแดรก 

 
 

ภาพท่ี 82 การพลิกวัตถุ 

 
 
การบิดวัตถุแบบเฉือน (Shear) 

 
 

ภาพท่ี 83 การบิดวัตถุแบบเฉือน 

 

การบิดวัตถุแบบเฉือนทําได้โดยการใช้เครื่องมือ Shear Tool  
วิธีท่ี 1 บิดแบบเฉือนอิสระตามการแดรกเมาส์ โดยใช้ลูกศรสีดําคลิกเลือกวัตถุที่ต้องการ แล้วคลิก
เลือกเครื่องมือ Shear Tool แล้วทําข้อใดขอ้หนึ่งดังต่อไปนี้ 
1. แดรกเมาส์เป็นการเฉือนวัตถุรอบจุดศูนย์กลาง 
2. คลิกเพ่ือกําหนดจุดอ้างอิง แล้วแดรกตรงไหนก็ได้เพ่ือบิดวัตถุแบบเฉือนรอบจุดอ้างอิงน้ัน 
การปรับแต่งอย่างอิสระด้วย Free Transform Tool 

นอกจากการใช้เครื่องมือเฉพาะในการปรับแต่งแล้ว เรายังสามารถปรับแต่งขนาดหรือรูปร่าง

ได้อย่างอิสระด้วยเครื่องมือ Free Transform Tool  
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ภาพท่ี 84 Free Transform Tool 

 
วิธีการใช้มีขั้นตอนดังนี้ 
1. ใช้ลูกศรสีดําเลือกวัตถุท่ีต้องการปรับแต่ง 
2. คลิกเลือกเครื่องมือ Free Transform Tool 
3.แดรกที่ตําแหน่งมุมของวัตถุ (Bounding Box) เม่ือเริ่มแดรกแล้วให้ทําข้อใดข้อหน่ึงต่อไปน้ี 

3.1 กดคีย์ Ctrl ค้างขณะแดรกจนกว่าจะได้รูปร่างท่ีต้องการแล้วปล่อยปุ่มเมาส์ เป็นการบิด
มุมด้านเดียว 

3.2 กดคีย์ Ctrl+Alt ค้างขณะแดรกจนจะได้รูปร่างท่ีต้องการแล้วปล่อยปุ่มเมาส์ จะเป็นการ
บิดแบบเฉือน 

3.3 กดคีย์ Shift+ Ctrl+Alt ขณะแดรกจนจะได้รูปร่างท่ีต้องการแล้วปล่อยปุ่มเมาส์ จะเป็น
การดัดรูปให้เป็น Perspective 
การใช้ Pathfinder 

Pathfinder เป็นสิ่งท่ีช่วยในการสร้างรูปได้สะดวกและรวดเร็วขึ้นมาก โดยเราอาจจะสร้าง
รูปร่างแต่ละส่วนเป็นช้ิน ๆ แล้วนํามาทํา Pathfinder เพ่ือให้เป็นรูปร่างใหม่ ซ่ึงจะเป็นช้ินเดียวกัน
วิธีการรวมร่างด้วย Pathfinder มีดังน้ี 
1. ใช้ลูกศรสีดําคลิกเลือกวัตถุท่ีซ้อนทับกันทีละช้ิน 
2. ถ้ายังไม่ได้เปิด Pathfinder Palette ให้เปิดโดยไปที่เมนูแล้วเลือก Window > Pathfinder หรือ 
กดคีย์ Shift +F9 
3. คลิกที่ปุ่มบน Pathfinder Palette ตามชนิดที่ต้องการ 

การใช้ Pathfinder ในการรวมร่างนั้นมีหลายรูปแบบ ขึ้นกับชนิดของการรวมร่างใน 
PathfinderPalette ซ่ึงจะมาทําความรู้จักกัน 

รายละเอียดของ Pathfinder Paletteในหน้าต่างของ Pathfinder Palette จะแบ่งเป็น 2 
หมวดด้วยกัน คือหมวด Shape Modes: เป็นการทําให้รูปร่างของวัตถุเปลี่ยนไป แต่รูปร่างของ Pat
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ยังคงเดิมสีและเส้นของวัตถุท่ีเกิดขึ้นใหม่จะมีผลตามลําดับการซ้อนทับของวัตถุเดิม โดยวัตถุท่ีอยู่หน้า
จะเป็นตัวหลักในการเปลี่ยนรูป ยกเว้น Subtract to Shape Areas เท่าน้ันท่ีใช้วัตถุท่ีอยู่หลังเป็น
หลัก 

 
 

ภาพท่ี 85 Pathfinder 

1. Add to Shape Area คือการรวมวัตถุทุกช้ินเป็นช้ินเดียวโดยเอาเส้นรอบรูปท้ังหมดรวมกัน 
2. Subtract to Shape Area คือการเอาวัตถุท่ีอยู่ด้านหลังตัดวัตถุที่อยู่ด้านหน้า3. คลิกที่ปุ่มบน 
Pathfinder Palette ตามชนิดที่ต้องการ 
3. Intersect Shape Area ใช้กับวัตถุ 2 ช้ิน โดยจะเหลือแต่ส่วนท่ีซ้อนทับกันไว้ 
4. Exclude Overlapping Shape Area เป็นการเจาะเอาส่วนท่ีซ้อนทับกันออกไปเหลือแต่ส่วนที่ไม่ 
ซ้อนทับกันไว้ 
5. Expand คือการลดรปู Path ของรูปร่างเดิมท้ังหมดให้เหลือเพียงชุดเดียว ผลท่ีออกมาจะ 
เหมือนกับการเลือกใช้หมวด Pathfinder ซ่ึงไม่สามารถคืนกลับเป็นรูปร่างเดิมได้อีก 
หมวด Pathfinders: จะเป็นการรวมรูปร่างโดยเปลี่ยนรูปร่างของ Path ต้นฉบับไปเลยไม่สามารถ 
แก้ไขกลับคืนมาเป็นรูปร่างเดิมได้ 
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ภาพท่ี 86 หมวด Pathfinders 

 
1. Divide คือการตัดแบ่งวัตถุท้ังหมดเป็นช้ิน ๆ ตามแนวเส้นขอบวัตถุเข้าด้วยกัน 
2. Trim การใช้วัตถุบนตัดวัตถุล่าง โดยลบส่วนท่ีถูกบังอยู่ออกไป และจะไม่รวมวัตถุเข้าด้วยกันแม้จะ
มีลักษณะของสีและเส้นเหมือนกันก็ตาม 
3. Merge คล้ายกับ Trim คือการใช้วัตถุบนตัดวัตถุล่าง โดยลบส่วนที่ถกูบังอยู่ออกไป แต่หากวัตถุมีลี
กษณะเดียวกันจะเป็นการรวมเข้าด้วยกัน 
4. Crop คือการเอาวัตถุบนเป็นกรอบในการตัดวัตถุล่าง วัตถุล่างอยู่นอกกรอบจะถูกลบทิ้ง 
5Outline คือการตัดแบ่งวัตถุเป็นช้ิน ๆ ในรูปของเส้น โดยยกเลิกสีและ Style ต่าง ๆ ออกหมดมี
ประโยชน์ในการใช้เตรียมอาร์ตเวิร์กในกระบวนการพิมพ์เพ่ือทํา Trap สําหรับทําสี Overprintเพ่ือ
ป้องกันสีเหลื่อม 
6. Minus Back คือการใช้วัตถุล่างตัดวัตถุบน 
การจัดเรียงวัตถุ (Align) 

ในการทํางานท่ีต้องการความมีระเบียบและแม่นยํา การย้ายวัตถุโดยการกะด้วยสายตานั้นไม่
เพียงพอวิธีที่ดีคือ การใช้ Align เข้าช่วย ในโปรแกรมประเภทกราฟฟิกทุก ๆโปรแกรมจะมีฟังช่ัน 
Align เพ่ือสะดวกในการจัดเรียงวัตถุให้ชิดกันหรือให้ขนานกันหรือให้เท่ากันหรืออ่ืน ๆ เพราะการ
จัดเรียงวัตถุจะช่วยให้ทํางานได้รวดเร็วและถูกต้องแม่นยํา  การเขียนลายมีความจําเป็นต้องใช้
เครื่องมือชนิดนี้อย่างขาดไม่ได้เพราะจะทําให้การทํางานได้ประสิทธิภาพหมดปัญหาเรื่องลวดลายซ้าย
ขวาไม่เท่ากัน หรือช่วยแก้ปัญหาลายบน ล่างไม่เท่ากัน ขั้นตอนการทํามีดังนี้ 
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ภาพท่ี 87 เครื่องมือจัดเรียงวัตถุ 

1. เลือกวัตถุท่ีต้องการจัดเรียง 
2. ถ้ายังไม่ได้เปิด Align Palette ให้เปิดโดยไปท่ี Window > Align หรอืกดคีย์ Shift + F7 
3. คลิกปุ่ม Align ชนิดที่ต้องการ 
การจัดลําดับการซ้อนทับวัตถุ (Arrange) 

เม่ือทํางานกับวัตถุหลาย ๆ ช้ินท่ีมีการวางทับกัน ลําดับในการซ้อนหน้าหรือหลัง จะมีผลต่อ
ภาพที่ปรากฏ วัตถุท่ีอยู่หน้าจะบังวัตถุท่ีอยู่หลัง วิธีการจัดลําดับซ้อนทับของวัตถุ ทําได้โดยการคลิก
เลือกวัตถุท่ีต้องการเปลี่ยนลําดับ แล้วคลิกเลือกเมนู Object > Arrange ซ่ึงมีเมนูย่อยให้เลือก 4 
อย่างดังน้ี 
Bring Forward ดึงขึ้นมาข้างหน้า 1 ขั้น 
Bring to Front คือดึงมาอยู่หน้าสุดของวัตถุทั้งหมดในเลเยอร์น้ัน 
Send Backward คือผลักไปข้างหลัง 1 ขั้น 
Send to Back คือผลักไปอยู่หลังสุดของวัตถุท้ังหมดในเลเยอร์นั้น 

 
 

ภาพที่ 88 การจัดลําดับการซ้อนทับ 
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โปรแกรมท่ีใช้สําหรับการออกแบบลวดลายหรือการสร้างลวดลายแกะสลักไม้ท่ีผู้วิจัยได้ใช้ใน
การออกแบบหรือการแก้ไขแบบได้แก่โปรแกรมFlash ซ่ึงลักษณะของโปรแกรมน้ีจะทํางานในลักษณะ
ภาพท่ีได้ออกมาเป็นภาพลายเส้นหรือเป็นภาพวาดแบบเวกเตอร์  ซ่ึงการทํางานจะเน้นได้ลายเส้น
เช่นเดียวกับโปรแกรมIllustrator จุเด่นของโปรแกรมFlashก็คือการวาดเส้นที่ง่ายและให้ความลวด
เร็วกว่าโปรแกรมอ่ืนๆ ซ่ึงผู้วิจัยได้ทดลองใช้ดูพบว่าการใช้เครื่องมือในการวาดเส้นค่อนข้างสะดวก
มากกว่าโปรแกรมอ่ืนมาก  โดยเฉพาะเครื่องมือSelectionท่ีสามารถวางไว้ใกล้เส้นก็สามารถดัดหรือ
ปรับแต่งเส้นได้ทันท่ีโดยไม่ต้องคลิกเลือกเครื่องมือใดๆเลย  ผู้ท่ีใช้เครื่องมือน้ีจะทํางานได้อย่างรวดเร็ว
โดยเฉพาะการทํางานเก่ียวกับการวาดเส้นหรือการวาดภาพต่าง ๆ งานวิจัยเล่มน้ีผู้วิจัยได้ทําการวาด
เส้นโดยการวาดลงกระดาษและผ่านโปรแกรมFlashเป็นส่วนใหญ่เน่ืองด้วยความสะดวกและความ
รวดเร็วดังท่ีได้กล่าวมาในข้างต้น  การแก้ไขเส้นให้ได้ขนาดตามต้องการก็ทําได้ง่ายซ่ึงโปรแกรมอ่ืนเช่น
โปรแกรมPhotoshopท่ีเป็นท่ีนิยมก็ไม่สามารถทํางานได้ดีเท่ากับFlash สําหรับในบทที่2นี้ผู้วิจัยจะได้
กล่าวถึงเครื่องมือของโปรแกรมFlashท่ีมีลักษณะใกล้เคียงกับโปรแกรมIllustratorมาก และในส่วนที่
เป็นการเขียนลายหรือการสร้างลายแกะสลักไม้ผู้วิจัยจะได้อธิบายอย่างละเอียดในบทท่ี 4 โดยมีการ
สร้างเป็นขั้นเป็นตอนอย่างละเอียด  โปรแกรมFlashมีความสามารถต่าง ๆ มากมายดังน้ี 

มีความสามารถในการสร้างสื่อการเรียนรู้ สื่อนําเสนอ หรืองานออกแบบต่างๆ ออกแบบ
สร้างสรรค์งานกราฟิก Flash เครื่องมือช่วยสร้างสรรค์งานกราฟิกที่ง่าย สามารถประยุกต์ใช้งานต่างๆ
ได้ดี Flash เป็นซอฟต์แวร์สร้างสรรค์งานกราฟิกในฟอร์แมต Vector ท่ีภาพกราฟิกทุกภาพประกอบ
จากเส้นโครงร่างที่ทําให้การปรับแต่ง แก้ไข หรือออกแบบภาพ ทําได้ง่ายด้วยเทคนิค “ตัด เช่ือม 
ปรับเปลี่ยนรูปร่าง ท้ังภาพน่ิง และภาพเคลื่อนไหว สําหรับการนําเสนอผ่านเครือข่ายอินเทอร์เน็ต 
Flash มีฟังก์ชันช่วยอํานวยความสะดวก ในการสร้างผลงานหลากหลายรูปแบบตลอดจนชุดคําสั่ง
โปรแกรมม่ิงท่ีเรียกว่า Flash Action Script ท่ีเพ่ิมประสิทธิภาพในการทํางาน  
การเรียกใช้โปรแกรม Flash 
การเรียกใช้งานโปรแกรม Flash มีหลักการคล้ายๆ กับการเรียกโปรแกรมทั่วๆ ไปของ
ระบบปฏิบัติการวินโดวส์ โดยเร่ิมจากการคลิกปุ่ม จากนั้นเลื่อนไปคลิกท่ีรายการ 
Program, Adobe Flash CS3 Professional ซ่ึงมีโหมดการทํางานให้เลือกได้หลายลักษณะได้แก่ 
• การเปิดไฟล์จากคําสั่ง Open a Recent Item 
• การสร้างงานผลงานจากรายการ Create New 
• การสร้างผลงานแม่แบบ Create from Template 
 
 
 



57 
 

ส่วนประกอบของ Flash 

 
 

ภาพท่ี 89 โปรแกรม Flash 

เมนูบาร์ (Menu Bar) 

 
 

ภาพท่ี 90 Menu Bar 

ไทมไลน์ (Timeline) 

 
 

ภาพที่ 91 Timeline 

 
ไทมไลน์ ใช้สําหรับสร้างหรือกําหนดรายละเอียดของการเคลื่อนไหว ไทมไลน์ถูกสร้างจาก

เฟรมที่เรียงต่อ ๆ กันในแนวนอน เฟรมสามารถปล่อยว่างได้ สามารถมีเนื้อหาได้ และสามารถมีคีย์
เฟรมได้ ไทมไลน์ถูกสร้างด้วยการเรียงกันของเลเยอร์ท่ีมีเน้ือหาและโค้ดของ Flash โดยแต่ละเลเยอร์
จะมี 1แถว ตัวช้ีตําแหน่งเฟรม Playhead จะช้ีตําแหน่งเฟรมที่กําลังทํางานอยู่บนไทม์ไลน์ในขณะนั้น 

 
 
 
 
 
 
 



58 
 

สเตจ (Stage) 

 
 

ภาพท่ี 92 Stage 

 
พ้ืนท่ีสีขาวบริเวณกลางจอคือ สเตจ เป็นพ้ืนท่ีใช้จัดวางออบเจ็กต์ต่าง ๆ ท่ีต้องการแสดงให้

เห็นในชิ้นงาน ส่วนพ้ืนที่สีเทาด้านนอกบริเวณสีขาวคือ Pasteboard เป็นบริเวณท่ีสามารถนํา
ออบเจ็กต์ต่าง ๆ มาวางพักไว้หรือวางซ่อนไว้ได้เพราะบริเวณนี้จะไม่แสดงผลเวลาที่เรา Export 
Movie เป็นไฟล์ .SWF 
พาเนล (Panels) 

พาเนล เป็นกรอบควบคุมต่าง ๆ ในการสร้างและแก้ไขงาน Flashพาเนลสามารถทําการเปิด
ปิดได้จากเมนูคําสั่งได้ นอกจากน้ันเรายังสามารถส่ัง Group พาเนลให้รวมกันเป็นกลุ่มได้อีกด้วย 

 
 

ภาพที่ 93 Panels 
 

ทูลบ็อกซ์ (Toolbox) 
ทูลบ็อกซ์ เป็นกล่องท่ีรวมเคร่ืองมือต่าง ๆ ท่ีใช้ในการสร้างและปรับแต่งออบเจ็กต์ โดยแต่ละ

เครื่องมือในทูลบ็อกซ์จะมีลักษณะเป็นไอคอนรูปภาพที่เราสามารถใช้งานได้ โดยเม่ือเราเลือกเครื่องมือ
ต่าง ๆ เพ่ือใช้งานแล้วเราสามารถปรับแต่งเพ่ิมเติมท่ี Options ด้านล่างของทูลบ็อกซ์  ์ได้ 



59 
 

 
 

ภาพท่ี 94 Toolbox 

 
Property Inspector 

 
 

ภาพท่ี 95 Property Inspector 

 
Property Inspector เป็นพาเนลชนิดหน่ีงท่ีแสดงคุณสมบัติต่าง ๆ ของออบเจ็กต์ท่ีเราคลิก

เลือก ซ่ึงเราสามารถปรับแต่งคุณสมบัติเหล่านี้ได้ ท้ังน้ีรายละเอียดของ Property Inspector จะ
เปลี่ยนไปตามออบเจ็กต์ท่ีเราเลือกอยู่ในขณะน้ัน 

 
Timeline 

 
 

ภาพที่ 96 Timeline 

 
Timeline  เป็นส่วนสําคัญท่ีทําหน้าท่ีควบคุมการนําเสนอผลงาน สามารถเปิด/ปิดด้วยคําสั่ง

นอกจากน้ีแล้วยังเป็นส่วนท่ีทําให้การแยกส่วนในการวาดเส้นตามท่ีผู้วิจัยได้วาดลวดลายดอกไม้โดย
สามารถแยกเป็นส่วนของดอก ใบ ก้าน หรือส่วนประกอบอื่นๆ ได้ตามต้องการซ่ึงสามารถแยกทํางาน
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ได้สะดวกและไม้บังหรือทับซ้อนกันให้ยุ่งยาก Timeline จะประกอบด้วยเลเยอร์ Layer ถือได้ว่าเป็น
ส่วนควบคุมการสร้างช้ันวัตถุ เพ่ือให้การควบคุมวัตถุแต่ละช้ิน มีอิสระ และสะดวกต่อการแก้ไข 
ปรับแต่งลวดลายของเราตามต้องการ 
Panel 

หน้าต่างเล็กๆ ท่ีทําหน้าท่ีแสดงคําสั่งควบคุมย่อยต่างๆ ของโปรแกรม โดยจะปรากฏรายการ
คําสั่งในเมนู Window Panel เป็นจอภาพเล็กๆ ท่ีแสดงฟังก์ชันการทํางานเฉพาะอย่าง เช่น การ
ทํางานเก่ียวกับสีจะควบคุมด้วย Color Mixer หรือ Color Swatches การจัดตําแหน่งวัตถุต่างๆ 
ควบคุมด้วย Align Panelเป็นต้น การเรียกใช้หรือเปิด/ปิด Panel จะใช้คําสั่ง Window แล้วตามด้วย
ช่ือ Panel นั้นๆ 

 
 

ภาพท่ี 97 Swatches 

 
เครื่องมือของ Flash 

การเขียนลวดลายหรือลายเส้นหรือสร้างภาพกราฟิกต่างๆ เราจะต้องใช้เครื่องมือจาก 
Toolbox โดยมีเครื่องมือหลายกลุ่มตามที่ผู้วิจัยได้แยกประเภทตามภาพด้านล่างน้ี 

 

เครื่องมือกลุ่มเลือกวัตถุ (Selection) 
ภาพท่ี 98 Selection 

 
 



61 
 

เครื่องมือกลุ่มวาดภาพ (Draw) 
ภาพท่ี 99 Draw 

 
 

เครื่องมือกลุ่มจัดการปรับแต่งแก้ไข (Edit) 
 

ภาพท่ี 100 Edit 

 
 

เครื่องมือกลุ่มแสดงผล (View) 
 

ภาพท่ี 101 View 

 

เครื่องมือกลุ่มจัดการสี (Color) 
 

ภาพท่ี 102 Color 

เครื่องมือกลุ่มคําสั่งเสริม (Tools Modifier) 
 

ภาพท่ี 103 Tools Modifier 

เคร่ืองมือวาดภาพ เป็นเคร่ืองมือท่ีสําคัญท่ีสุดในการใช้ทํางานวิจัยเล่มน้ี  การวาดเส้นจะเกิดได้จาก
การใช้เครื่องมือที่ใช้การวาดไม่ว่าจะเป็นปากกา  ดินสอ  แปรงหรือพู่กัน 
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Pen Tool  เครื่องมือชนิดนี้มีรูปร่างหน้าตาท่ีเป็นรูปปากกาซ่ึงแสดงให้เห็นว่าเป็นการวาดโดยได้
เส้นออกมาคล้ายคลึงกับการวาดด้วยปากกา  เครื่องมือชนิดน้ีจะมีอยู่ในโปรแกรมประเภทวาดเส้น
หรือวาดภาพ  ลักษณะเส้นท่ีได้จะมีความคมชัดสามารถกําหนดขนาดเส้นให้มีขนาดได้ตามต้องการ  
ซ่ึงแตกต่างจากการวาดด้วยเครื่องมือประเภทพู่กันหรือแปรง  จะได้ในลักษณะที่เป็นเส้นแบบฟรี
ฟอร์มมากกว่า จากภาพด้านล่างเป็นการใช้ Pen Tool ร่ามกับการใช้เลเยอร์แยกช้ินส่วนของลาย 
 

 
 

ภาพท่ี 104 แสดงเลเยอร์แยกช้ันของลาย 
 

 
 

ภาพท่ี 105 เปิดเลเยอร์ท้ังหมด 
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ทํางานกับสี (Color)วัตถุใน Flash จะประกอบด้วยส่วนประกอบ ได้แก่ พ้ืนของวัตถุ(Background 
หรือ Fill) และเส้นขอบวัตถุ (Stroke) ซ่ึงในส่วนของการวาดลวดลายจะเน้นการใช้เส้นหรือเส้นขอบ
วัตถุเป็นหลัก  สําหรับการใช้สีอาจจะใช้ในการเทสีทําให้เกิดสีสันต่าง ๆ ได้ทุกเฉดสี 
 

 
 

ภาพที่ 106 สีและเส้นขอบ 
 
แผงควบคุมสี (Color Panel) จะช่วยในการทํางานเก่ียวกับสี โดยเฉพาะในส่วนท่ีเป็นการไล่โทนสี 
(Gradient) เน่ืองจากการสร้างชุดสีการไล่โทน ไม่สามารถทําได้จากส่วนควบคุมสีปกติ Flash เตรียม 
Panel เกี่ยวกับสีไว้ 2 ชุดคือSwatchesและColor ซ่ึงท้ังสองส่วนน้ีมีลักษณะการทํางานเกี่ยวกับสีท้ัง 
คู่โดยส่วนท่ีเป็นSwatches จะสามารถใช้ได้ท้ังเส้นขอบและสีช้ินงาน แต่สําหรับColor จะเน้นในส่วน
ของการใช้สีช้ินงานหรือFill Colorขอบมากกว่า 
 

 
 

ภาพท่ี107 กําหนดขนาดของเส้น 
 

รายการเลือก No Color จะแสดงผลเม่ือคลิกเลือกวาดสี่เหลี่ยม หรือวาดวงกลม ดังนั้นก่อน
เลือกสีให้กับการวาดสี่เหลี่ยม, วงกลม ควรคลิกเลือกเครื่องมือวาดสี่เหลี่ยม หรือวาดวงกลมก่อนท่ีจะ
คลิกปุ่มเลือกสี ซ่ึฝ เป็นรายการสําคัญมาก และมักจะเป็นรายการท่ีเข้าใจผิด เช่น ถ้าต้องการวาด
วงกลมไม่มีสีพ้ืน หลายๆ ท่าน จะใช้วิธีการเลือก Fill Color ให้กับสีของ Backgroundเช่น ถ้า 
Background เป็นสีขาว ก็จะเลือก Fill Color เป็นสีขาว ซ่ึงมีความหมายท่ีต่างไป 
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เครื่องหมายห้ามสีตรงบริเวณลูกศร 
 

ภาพท่ี 108 เคร่ืองหมายห้ามสี 
นอกจากการวาดเส้นท่ีใช้ดินสอ แปรง หรือเส้นแล้วยังมีเครื่องมือที่มีความสําคัญเก่ียวกับการ

ใช้วาดลวดลายหรือการวาดเส้นได้แก่ เครื่องมือวาดเส้นสําเร็จรูปหรือเครื่องมือวาดเลขาคณิต  
เครื่องมือชนิดนี้มีความสําคัญมากเพราะสามารถใช้ในการทํางานที่มีความรวดเร็วและเรียบร้อยกว่า
การวาดด้วยดินสอหรือแปรง เช่นการวาดวงกลมของเกษรดอกไม้หรือวงกลมของแมลง  หรือสี่เหลี่ยม
ท่ีเป็นกรอบของกรอบรูป หรือการสร้างวงรีต่าง ๆ หากเป็นการใช้เครื่องมือชนิดอ่ืนก็จะทํางานได้
ลําบากและไม่พอดีกับความต้องการ 

 
 

ภาพที่ 109 การใช้วงกลมวาดส่วนหัวและตัวลายผีเส้ือ 
 
 ภาพด้านบนเป็นชุดคําสั่งการใช้เครื่องมือเลขาคณิตหรือเครื่องมือสําเร็จรูป ได้แก่ สี่เหลี่ยม 
วงกลม วงรี รูปดาว รูปหลายเหลี่ยม  
ปรับแต่ง แก้ไขวัตถุจุดเด่นของการสร้างวัตถุด้วย Flash ก็คือวัตถุ หรือกราฟิกที่สร้างไว้แล้ว สามารถ
ปรับแต่งแก้ไข ปรับเปลี่ยนรูปทรง ขนาด และลักษณะได้ง่าย รวดเร็ว กราฟิกจาก Flash เกิดจากการ
รวมกันของ “จุด” ทําให้การปรับแต่ง เปลี่ยนรูปทรงกระทําได้ง่าย และสะดวก เพียงแต่ใช้หลักการ
Drag & Drop ก็ทําให้รูปทรงพ้ืนฐาน เช่น วงกลม, วงรี,สี่เหลี่ยม เป็นสภาพเป็นรูปทรงอิสระอ่ืนๆ ได้
ตามต้องการ เช่น 
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ภาพท่ี 110 การใช้เคร่ืองมือSelect 
 

กล่าวสรุปได้ว่าโปรแกรม Flashและ Illustrator เป็นโปรแกรมท่ีเหมาะสําหรับการใช้งาน
ด้านกราฟฟิกดีไซด์ซ่ึงรวมไปจนถึงการวาดแบบ เขียนแบบ วาดเส้น คัดลอกแบบหรืออ่ืน ๆ ท่ี
เกี่ยวข้องกับการวาดเส้นและการลงสี จากการที่ผู้วิจัยได้ทดลองทําท้ังสองโปรแกรมเกี่ยวกับในด้าน
การเขียบแบบเป็นลายเส้นเพ่ือนําไปใช้ในการสร้างแบบแกะสลักพบว่าการทํางานได้ผลออกมา
เหมือนกันหรือใช้แทนกันได้เพราะได้เส้นท่ีมีความคมชัดสูงมาก  สามารถท่ีจะขยาดได้โดยเส้นไม่แตก 
และที่สําคัญสามารถทําเส้นได้ตรงกับความต้องการได้มากหรือมีความหลากหลาย  สําหรับการใช้ใน
การเขียนแบบอาจจะไม่มีความจําเป็นต้องใช้เครื่องมือเกี่ยวกับการทําสีหรือการลงสีช้ินงานแต่อย่างใด  
โปรแกรมFlashสามารถทํางานในด้านการวาดเส้นท่ีมีความสะดวกรวดเร็วกว่าโปรแกรมIllustrator
เพราะมีเครื่องมือท่ีเรียกว่าเคร่ืองมือ Selectซ่ึงเครื่องมือชนิดน้ีสามารถช้ีลงบนเส้นได้เพ่ือให้มีการ
เคลื่อนย้ายได้ตามต้องการว่าจะให้เส้นเคลื่อนย้ายหรือเปลี่ยนแปลงไปทางไหนได้ทันที  ต่างกับ 
SelectในโปรแกรมIllustrator ท่ีเป็นเครื่องมือที่ใช้ในการเลือกเส้นเท่านั้น  หากต้องการแก้ไข
เกี่ยวกับเส้นต้องกําหนดเครื่องมืออ่ืนแทนเช่น  ใช้เครื่องมือPentool เป็นตัวคอยกํากับการวาดเส้น  
อย่างไรก็ดีโปรแกรมFlashก็ยังสามารถใช้เครื่องมือPentoolได้เช่นกัน  นี่จึงเป็นข้อแตกต่างกัน
ระหว่างสองโปรแกรมน้ี  อย่างไรก็ดีการใช้โปรแกรมก็สามารถเลือกได้ตามท่ีตนเองถนัดซ่ึงได้ผลงาน
สําเร็จที่ได้อย่างพอๆ กัน  ในส่วนของการสร้างลวดลายแกะสลักอาจจะต้องนําโปรแกรมท่ีสําคัญมา
ช่วยในด้านการจัดการกับรูปภาพ  ซ่ึงโปรแกรมน้ีได้แก่โปรแกรม Photoshop ถือได้ว่ามีความจําเป็น
อย่างย่ิงต้ังแต่เริ่มต้นโดยการนําเอาภาพถ่าย  หรือจะใช้วิธีผ่านเครื่องสแกน หรือถ่ายจากกล้อง หรือ
จากการดาวน์โหลดจากอินเตอร์เน็ตซ่ึงทั้งสามกระบวนการน้ีจําเป็นต้องใช้โปรแกรม Photoshop 
ช่วยในการกําหนดขนาด  หรือใช้แก้ไขส่วนท่ีไม่ต้องการออกก่อนเรียกว่ากระบวนการรีทัสภาพ  จาก



66 
 

การที่ผู้วิจัยได้ทําการสร้างลวดลายแกะสลักก็จะต้องใช้โปรแกรมนี้จัดการกับรูปภาพให้เรียบร้อย
เสียก่อน  โดยหลังจากน้ันจึงค่อยนําเอามาผ่านโปรแกรมท่ีใช้วาดเส้นต่อไป  เม่ือได้ทําการเสร็จ
เรียบร้อยก็จะต้องมาจบที่โปรแกรมPhotoshop อีกเช่นกันเพ่ือจะได้กําหนดขนาดท่ีชัดเจน  หรือตรง
กับขนาดไม้ท่ีเราต้องการแกะสลักดังน้ันการจัดการเกี่ยวกับรูปภาพจะเป็นกระบวนการท่ีสําคัญมาก ๆ 
ก่อนท่ีจะสร้างลวดลายและหลังจากสร้างลวดลายแล้ว  ขั้นตอนการร่างแบบอาจจะเป็นการร่างบน
กระดาษก่อนก็ได้ท้ังน้ีก็ขึ้นอยู่กับความถนัด  ซ่ึงบางครั้งการออกแบบร่างก็ยังสามารถใช้คอมพิวเตอร์
สร้างได้เลยในขั้นตอนเดียวและจะเป็นการเพ่ิมความสะดวกในการทํางานอีกด้วยในปัจจุบันได้มีเมาท์ท่ี
เป็นปากกาผลิตออกมาเพ่ือตอบสนองการทํางานทางด้านกราฟฟิก  ซ่ึงสามารถทํางานได้เหมือนกับ
การวาดด้วยดินสอหรือภู่กัน  การใช้เมาท์ปากกาจึงเป็นสิ่งจําเป็นสําหรับงานด้านการเขียนลวดลาย  
โดยเฉพาะกับโปรแกรมFlash จะสามารถทํางานได้สะดวกมาก  หากเปรียบเทียบกับการใช้เมาท์แบบ
ธรรมดาการทํางานจะลําบากมากโดยเฉพาะเรื่องการเขียนลาย 
 

 
 

ภาพท่ี 111 เมาท์ปากกา 
 

 ดังเห็นได้จากภาพด้านล่างนี้เป็นการจัดการเกี่ยวกับรูปภาพที่ร่างบนกระดาษก่อนและผ่าน
การสแกนเข้ามา  ซ่ึงการเขียนลายท่ีดีควรจะทําทีละขั้นตอนหรือแยกทําในส่วนต่าง ๆ เช่นภาพ
ด้านล่างเป็นการเขียนแบบกล่องใส่เครื่องประดับแบบเป็นลวดลายฉลุ  การเลือกพ้ืนท่ีจากรูปร่างด้าย
ซ้ายมาบางส่วนจะทําให้การทํางานง่ายขึ้นและเราจะกําหนดขนาดได้ตามท่ีเราต้องการได้  และเม่ือ
เสร็จขั้นตอนการสร้างลวดลายก็จะค่อยนําไฟล์งานที่ได้มารวมกันในภายหลังก็ได้  ท้ังน้ีการกําหนด
พ้ืนท่ีลวดลายจําเป็นต้องรู้ขนาดของไม้เสียก่อนเพราะขนาดของไม้จะเป็นตัวกําหนดให้เราต้องกําหนด
ขนาดของกระดาษในคอมพิวเตอร์  หากไม่กําหนดขนาดไม้ก่อนก็จะทําให้เกิดปัญหาในการย่อหรือ
ขยายแบบในภายหลัง  อย่างไรก็ดีเม่ือรู้ขนาดของไม้แล้วหากต้องการเปลี่ยนแปลงแบบ ก็สามารถท่ีได้
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โดยการแก้ไขแบบให้ได้ขนาดไม้ท่ีมีการเปล่ียนแปลงได้เช่นกัน  ซ่ึงการแก้ไขแบบด้วยคอมพิวเตอร์เป็น
เรื่องที่ทําได้ง่ายและรวดเร็วมาก หากเป็นเม่ือก่อนท่ีไม่ได้ใช้คอมพิวเตอร์ก็จะต้องนําแบบไปย่อขยาย
ในเครื่องถ่ายเอกสารซ่ึงบางคร้ังก็จะเกิดการผิดเพ้ียนของลายเส้นหรือแบบได้  ถ้าเป็นกรณีที่ต้องการ
แก้ไขลวดลายก็อาจจะต้องเขียนลายกันใหม่ซ่ึงเสียเวลามากและอาจจะไม่ได้ความถูกต้องตามแบบเดิม
ได้ 
 

 
 

ภาพท่ี 112 ลายกล่องเครื่องประดับเข้าคอมพิวเตอร์ด้วยการสแกนผ่านโปรแกรมPhotoshop 
 

 
 

ภาพท่ี 113 ลายกล่องเครื่องประดับเขียนด้วยคอมพิวเตอร์ 
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 ในการวางแบบลงบนไม้จําเป็นต้องเตรียมไม้ให้ได้ขนาดท่ีต้องการก่อน  แล้วจึงกําหนดขนาด
ลงในคอมพิวเตอร์จากนั้นจึงสั่งพิมพ์เป็นรูปภาพออกมาแล้วทากาวทับลงบนไม้  เราก็จะได้ชิ้นงานท่ี
ถูกต้องตามขนาดที่เราต้องการแล้วจึงนําไปแกะสลักในขั้นตอนต่อไป  ภาพด้านล่างนี้ก่อนท่ีจะได้
ลวดลายมาก็ต้องผ่านโปรแกรมกราฟฟิกเพ่ือทําการวาดเส้นให้ได้ตามแบบร่างเสียก่อน จากนั้นจึงได้
พิมพ์ออกมาใช้งานตามขนาดของไม้  แบบท่ีเราได้จะมีความคมชัดและสามารถทํางานได้สะดวก
รวดเร็วไม้ว่าจะเป็นการแก้แบบให้มีขนาดเล็กลงหรือใหญ่ขึ้นก็จะทําได้สะดวก  เพียงแค่แก้ไขแบบใน
คอมพิวเตอร์เท่านั้น 
 

 
 

ภาพท่ี 114 ลายเถาตําลึงเขียนด้วยคอมพิวเตอร์ 

 

 
 

ภาพท่ี 115 ภาพต้นแบบ 
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ภาพท่ี 116 ภาพลายเส้นดอกพุดตาล 
 

การแกะสลักไม้ 
ก่อนที่จะลงมือปฏิบัติการแกะสลักไม้   การรู้จักกับเครื่องมือเเละอุปกรณ์จะช่วยการ

ปฏิบัติงานได้อย่างสะดวก    รวดเร็วเเละปลอดภัยเคร่ืองมือช่างไม้ท่ีเราได้ใช้อยู่ในในปัจจุบันนี้ได้เคยมี
คิดค้นประดิษฐ์และใช้นานมาแล้ว  เม่ือประมาณสามเเสนปีมาเเล้วซ่ึงในระยะเเรกๆเป็นเครื่องมือท่ี
หยาบๆส่วนมากจะทําขึ้นด้วยหินหรือกระดูกสัตว์ เครื่องมือยุคหินนี้เป็นเคร่ืองมือช้ินแรกท่ีมนุษย์ได้
สร้างขึ้นเพ่ือใช้ประโยชน์ในด้านการดํารงชีพโดยการล่าสัตว์มาเป็นอาหารซ่ึงมนุษย์เราในยุคน้ียังไม่ได้
ดํารงชีพโดยการเพาะปลูกหรือกินพืชเป็นอาหาร 

   

 
 

ภาพที่ 117 ภาพแสดงเครื่องมือยุคก่อนประวัติศาสตร์ 
 Herman Hjorth.1980:1 

 
 สําหรับเคร่ืองมือท่ีเกิดขึ้นต่อจากเครื่องมือยุคหินได้มีวิวัฒนาการโดยการขุดเอาโลหะมาทํา
เป็นเครื่องมือเคร่ืองใช้ต่าง ๆเครื่องมือยุคน้ีจะเป็นเครื่องมือที่นําเอาเหล็กหรือโลหะมาประกอบกับกับ
ด้ามท่ีทําด้วยไม้หรือกระดูกสัตว์ มนุษย์ยุคนี้รูจักศิลปะและความงามสนองความต้องการทางด้านจิตใจ
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โดยสังเกตุได้จากหลักฐานท่ีขุดพบมักจะมีลักษณะของเครื่องมือที่ทําด้วยโลหะหรือเรียกได้ว่าเป็น
เครื่องมือยุคสําริด การสร้างเคร่ืองมือมีความประณีตมากกว่าเคร่ืองมือยุคหินมาก ประโยชน์ใช้สอยก็
ไม่ได้มีไว้สําหรับการล่าสัตว์เท่าน้ันแต่ยังสามารถใช้สร้างเป็นที่อยู่อาศัยได้อีกด้วย 
 

 
 

ภาพท่ี 118 ภาพแสดงเครื่องมือท่ีทําด้วยโลหะสําริด 
Herman Hjorth.1980:1 

 
จากหลักฐานท่ีปรากฏพบว่าในศตวรรษท่ี19  ชาวโรมันเป็นชาติแรกที่ได้ประดิษฐ์เลื่อยขึ้นมา

เป็นชาติเเรกตลอดจนกบไสไม้เเละฆ้อนหงอนตอกตะปู   เครื่องมือช่างไม้ได้มีวิวัฒนาการมาเป็นลําดับ
เม่ือมนุษย์ได้นําเหล็กที่มีคุณภาพดีมาทําเป็นเคร่ืองมือ  เช่นการทําดอกสว่านซ่ึงเริ่มมีใช้กันอย่างเเพร่
หลายกันในศตวรรษที่18 เช่นกัน เเละหลังจากมีการปฏิวัติทางด้านอุตสาหกรรมก็ย่ิงทําให้การผลิต
เครื่องมือเเละอุปกรณ์เกี่ยวกับงานไม้มีคุณภาพดีย่ิงขึ้นประเทศเยอรมันนีเป็นประเทศที่ขึ้นช่ือในด้าน
การผลิตเครื่องมือช่างไม้    จะเห็นได้ว่าเครื่องมือเเบรนด์เนม ท่ีมีช่ือเสียงมักจะเร่ิมต้นผลิตท่ีประเทศ
เยอรมัน   ระยะหลังการผลิตเคร่ืองมือได้เเพร่ขยายไปทั่วยุโรปและอเมริกาสําหรับในเอเชียการผลิต
เครื่องมือท่ีมีคุณภาพที่ไม่เเพ้ทางยุโรปเเละอเมริกาได้เเก่ประเทศญ่ีปุ่นเครื่องมือช่างไม้ในสมัยโบราณ
เป็นเคร่ืองมือท่ีเป็นเเบบง่ายๆ   ยกตัวอย่างเช่นสว่านท่ีใช้เชือกเป็นแกนหมุนทําให้ดอกสว่าน
เคลื่อนไหวไปมาได้   เเละเจาะหรือใช้งานได้จริงนับเป็นเวลาหลายศตวรรษมาเเล้วท่ีมนุษย์ท่ีมนุษย์ได้
พัฒนาเคร่ืองมือช่างไม้ขึ้นมาอย่างกว้างขวาง  ไม่ว่าจะเป็นเครื่องมือที่ใช้เลื่อย  ไส  ตอก  เจาะ 
เครื่องมือ  ช่างไม้เป็นกลุ่มเครื่องมือประเภทหนึ่ง ท่ีควรมีไว้ประจําบ้านท้ังนี้เพ่ือความสะดวกในการ
หยิบใช้ ในกรณีท่ีต้องการ  ซ่อมเเซมบ้านเรือนหรือซ่อมเฟอร์นิเจอร์หรืองานอ่ืนๆ  โดยท่ัวไปเครื่องมือ
เเบ่งออกเป็น 2  กลุ่มใหญ่ได้เเก่เครื่องมือช่างไม้ท่ัวไป (Hand Too) ยกตัวอย่างเช่น ฆ้อน  เลื่อย  สิ่ว  
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กบไสไม้  เครื่องมืออีกประเภทได้เเก่ เครื่องมือกล (Power  Tool) หรือเคร่ืองมือไฟฟ้า  เครื่องมือ
ประเภทน้ีเป็นเคร่ืองมือที่ทุ่นเเรงทุ่นเวลาในการทํางานยกตัวอย่างเช่น กบไฟฟ้า  สว่านไฟฟ้า  เครื่อง
ขัดกระดาษทราย  ฯลฯการได้เรียนรู้เเละได้ศึกษาการใช้เครื่องมือช่างไม้    อย่างถูกต้องตามหลักการ
ใช้เครื่องมือในแต่ละชนิดในแต่ละชนิดนับเป็นเรื่องท่ีสําคัญที่สุดในกระบวนการสร้างงานเครื่องไม้  
เพราะจะทําให้เครื่องมือที่ใช้สามารถทํางานได้เต็มประสิทธิเเละมีความคงทน การทํางานก็จะเป็นเรื่อง
ท่ีง่ายเเละจะทําให้มีความสุขกับการทํางานในบทนี้ผู้เขียนจะได้อธิบายถึงเคร่ืองมือเครื่องจักรเเละ
อุปกรณ์เกี่ยวกับงานเครื่องไม้เพ่ือเป็นเเนวทางในการสร้างสรรค์ช้ินงานได้อย่างสมบูรณ์เเบบเครื่องมือ
ท่ีใช้ในการตกแต่งไม้อีกชนิดหน่ึงท่ีมีความสําคัญมากอีกอย่างหนึ่งบของงานช่างไม้  สิ่วมีหน้าท่ีในการ
เจาะไม้  บากไม้  เซาะไม้ แกะสลักไม้ ฯลฯ สิ่วสามารถแบ่งออกเป็นประเภทต่างๆได้หลายชนิดดังนี้  
ส่ิว( Gouges) 

 สิ่วเป็นเครื่องมือท่ีทํางานได้เร็วมากโดยมีส่วนปลายเป็นเหล็กคมและ  ส่วนด้ามที่ทําด้วยไม้
หรือไฟเบอร์  คมของส่ิวมีท้ังท่ีเป็นแนวตรงหรือแนวโค้งเพ่ือใช้สําหรับการเซาะเนื้อไม้ออกโดยไม่ทําให้
เนื้อไม้แตก  การจําแนกสิ่วโดยท่ัวไปมักจะจําแนกตามระยะแนวสิ่วไม่ว่าจะเป็นแนวโค้งหรือแนวตรง 
เลิศพงษ์ ชีวพัฒนพันธ์ุได้จําแนกสิ่วสําหรับงานเครื่องไม้ไว้ 3 ชนิดได้แก่  
 1. สิ่วปากบาง  หมายถึงสิ่วท่ีใช้สําหรับการปาด ตอก เฉือน หรือแซะปากไม้  สิ่วชนิดนี้มี
ลักษณะที่มีความกว้างมากกว่าความหนาของสิ่ว  หรือคล้ายกับใบกบใสไม้โดยท่ัวไปแล้วสิ่วจะมีความ
กว้างต้ังแต่ครึ่งน้ิวถึงสองนิ้ว สิ่วปากบางจะมีส่วนประกอบ 2 ส่วนเช่นเดียวกับสิ่วชนิดอ่ืน ๆ คือ ส่วนท่ี
เป็นใบสิ่วและส่วนที่เป็นด้ามซ่ึงอาจทําด้วยไม้หรือไฟเบอร์ 
 

 
  

ภาพท่ี 119 ส่ิวปากบาง 
 

 2. สิ่วเดือย  หมายถึงสิ่วท่ีใช้ในการเจาะรูเพ่ือใช้ประกอบกับเดือย  โดยลักษณะรูปร่างท่ีมี
ความแตกต่างจากสิ่วปากบางตรงท่ีสิ่วเดือยจะมีความหนาของใบสิ่วอย่างเห็นได้ชัดเจน  หรือมี
ลักษณะเป็นเหล็กกล่องหรือเหล็กรูปตัดเป็น 4 เหลี่ยม สิ่วชนิดน้ีทนต่อแรงตอก แรงงัดได้มาก  ขนาด
ของสิ่วเดือยมีต้ังแต่1/8 -3/4 นิ้วด้านหน้าจะมีลักษณะเป็นแนวเฉียงจากด้ามถึงคมสิ่วโดยคมสิ่วจะลาด
เอียง 60 องศา  ส่วนท่ีเป็นคมอยู่ท่ีส่วนล่าสุดของหลังคมสิ่วกับเส้นความลาดเฉียงจากหน้าสิ่วมา
บรรจบกัน  ส่วนบนสุดของใบสิ่วเป็นด้ามสิ่วทําด้วยไม้กลึงหรือไฟเบอร์ 
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ภาพท่ี 120 ส่ิวเดือย 
                                                                                                     

3. สิ่วแกะสลัก  หมายถึงสิ่วท่ีใช้สําหรับงานท่ีขุด เซาะ แกะลงบนเน้ือไม้ให้เกิดร่องรอยหรือ
ลวดลายหรือเกิดรูปทรงต่างๆ  สิ่วขุดสลักนับเป็นสิ่วท่ีเหมาะกับงานเครื่องไม้สามารถสร้างงานศิลปะ
ได้มากมายหลากหลายรูปแบบไม่ว่าจะเป็นงานแกะสลักนูนตํ่า  นูนสูง  หรือลอยตัว  สิ่วชนิดนี้
สามารถใช้งานได้แทบทุกประเภท  ลักษณะของส่ิวแกะสลักจะมีรูปร่างหน้าตาที่มีความหลากหลาย
เช่น สิ่วหน้าตรง  สิ่วเล็บมือหรือรูปตัวยู  สิ่วตัววี  สิ่วหางปลา  สิ่วช้อน  สิ่วเซาะร่อง ฯลฯ 

 

 
 

ภาพท่ี 121 ส่ิวแกะสลักท่ีผลิตจากประเทศเยอรมันนี 
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ภาพท่ี 122 ภาพแสดงส่ิวแกะสลักผลิตขึ้นท่ีอยุธยา 

 
 

 
 

ภาพท่ี 123 ภาพแสดงรูปแบบส่ิวแกะสลัก 
John L.Feirer1997:26 

 

 

 
 

 ภาพท่ี 124 ภาพแสดงส่ิวแกะสลักผลิตท่ีเชียงใหม ่
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การใช้และการบํารุงรักษาส่ิว 
1. ควรเก็บสิ่วไว้อย่างดีโดยไม่ให้เกิดการกระแทกกันเพราะจะทําให้คมสิ่วสึกหรือเป็นรอยบิ่น

ได้ 
2. การตอกด้ามสิ่วไม่ควรใช้ฆ้อนเหล็กตอกด้ามสิ่ว  ทางท่ีดีควรจะใช้ค้อนไม้เพราะจะทําให้ไม่

เกิดการแตกร้าวของด้ามสิ่ว 
3. การใช้สิ่วควรระมัดระวังอันตรายและไม่ควรหันคมสิ่วเข้าหาตัวขณะที่ทําการตอก 
4. การใช้สิ่วที่ทื่อจะทําให้เสียเวลามากและทําให้งานเสียหาย  ก่อนใช้งานควรทําการลับคม

ส่ิวเสียก่อน 
5. การใช้สิ่วควรเลือกขนาดให้เหมาะสมกับงาน  การที่ใช้สิ่วขนาดเล็กออกแรงงัดอาจจะทําให้

ส่ิวงอหรือหักได้ 
6. หลังจากเลิกใช้งานให้ทําการทาด้วยน้ํามันกันสนิมทุกครั้ง  เพราะสิ่วเป็นเครื่องมือท่ีเกิด

สนิมได้ง่าย 
 สรุป  การออกแบบลวดลายเป็นการสร้างสรรค์งานศิลปะประเภทงานแกะสลักไม้  ในอดีต
การออกแบบลวดลายเป็นภูมิปัญญาท่ีสืบทอดต่อกันมา การเขียนลายในแต่ละครั้งทําได้ยากลําบาก
กว่าในปัจจุบันมาก การที่เรามีเครื่องคอมพิวเตอร์เป็นเพียงการตอบสนองความรวดเร็ว และสร้าง
ความสะดวกได้มากแต่หากว่าเราไม่มีความสามารถในการออกแบบลวดลายมาก่อน  การใช้
คอมพิวเตอร์จะไม้ได้ช่วยอะไรได้มากเวลาที่ใช้ในการออกแบบจะได้ประสบการณ์จากการฝึกปฏิบัติใน
การวาดด้วยมืออย่างชํานาญเสียก่อน  เพราะการวาดด้วยมือสามารถที่จะควบคุมนํ้าหนักมือได้อย่างดี
ท่ีสุด  และไม่มีเครื่องมือชนิดใดที่จะมาแทนได้แม้กระท้ังคอมพิวเตอร์  การออกแบบลวดลายแกะสลัก
สามารถพัฒนารูปแบบและความหลากหลายข้ึนอยู่กับแนวคิดและประสบการณ์  ดังนั้นก่อนที่ผู้วิจัย
จะได้ทํางานวิจัยเล่มน้ี  ผู้วิจัยได้มีการฝึกปฏิบัติการเขียนลายด้วยมือหรือมีประสบการณ์ในการวาด
เส้น หรือการวาดเขียนท้ังที่เป็นลวดลายและงานอ่ืน ๆ การออกแบบลวดลายที่ดีควรจะต้องมีการฝึก
จากง่าย ๆ ไปก่อนโดยเฉพาะการเขียนลายดอกไม้เช่นลายพุฒตาลนับว่าเป็นลายพ้ืนฐาน  หรือทาง
ช่างมักเรียกกันว่าลายครูรองมาจากการเขียนกนกสามช้ัน   ลายดอกพุฒตาลเป็นลายที่ไม่บ่งบอกว่า
เป็นลวดลายไทยมากนัก  ถึงแม้ว่างานศิลปะไทยจะมีการใช้ดอกไม้หรือลายดอกพุฒตาลอย่าง
แพร่หลายก็ตาม  จากการศึกษาจะเห็นได้ว่าไม่ว่าจะเป็นลวดลายจีน หรือทางตะวันตกก็มักจะมีลาย
ดอกไม้ท่ีมีลักษณะคล้ายกับลายดอกพุฒตาลของไทย  แต่การเรียกช่ือก็อาจจะเรียกต่างกันไปแต่ใน
รูปแบบที่มีจะมีลักษณะการผูกลายหรือส่วนประกอบของลายใกล้เคียงกัน  เช่น การมีดอกและกลีบ
ดอกท่ีเป็นแบบเดียวกัน  การมีใบที่ทับซ้อนและมีรูปร่างคล้ายๆ กัน โดยเฉพาะการวางใบจะมีลักษณะ
ท่ีเหมือนกันมากกว่าพวกดอก  ส่วนก้านท่ีเป็นส่วนประกอบท่ีสําคัญก็จะมีความแตกต่างกันมากท่ีสุด 
ในลวดลายฝร่ังหรือลายทางตะวันตกการวางก้าน  จะเป็นในลักษณะก้านขดท่ีมีจังหวะประกอบไปกับ
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ใบพร้อมๆ กันหรือที่เรียกว่าก้านใบแบบผักกูดซ่ึงมีความสวยงามและจะมีความโดดเด่นมากกว่าดอก  
ต่างกับลายไทยจะเน้นในส่วนที่เป็นดอกมากกว่า  จากการศึกษาลวดลายตะวันตกซ่ึงตกทอดมาต้ังแต่
สมัยกรีก โรมัน ลวดลายต่างไม่ว่าจะเป็นงานเขียน  งานป้ัน  งานหล่อ หรืองานแกะสลัก  จะนิยมเน้น
ในเร่ืองของมากกว่าดอก  ซ่ึงก็เป็นเอกลักษณ์อย่างหน่ึงท่ีมีความสวยงามวิจิตรบรรจง  เม่ือ
เปรียบเทียบกับงานไทยจะพบว่าการสร้างลวดลายมีความแตกต่างกัน  โดยเฉพาะลวดลายไทยโบราณ
จะเป็นลวดลายแบบอุดมคติซ่ึงเป็นลักษณะลายท่ี  เป็นนามธรรมหรือเชิงสัญลักษณ์มากว่าลายทาง
ตะวันตก  อย่างไรก็ดีลวดลายท่ีถือกําเนิดในภูมิภาคน้ีก็ไม่ได้บ่งบอกได้อย่างแน่ชัดว่าเป็นลายไทยหรือ
ลายเพ่ือนบ้านใกล้เคียง  จากการศึกษาพบว่าลายไทยเป็นลวดลายที่มีลักษณะเป็นแบบเดียวกับพม่า 
ลาย กัมพูชาหรือแม้กระท้ังในมาเลเซีย  ข้อมูลต่าง ๆ พอสรุปได้ว่าลายไทยเป็นลายท่ีเรียกกันเป็นส่วน
เฉพาะของไทยเท่านั้นไม่สามารถบ่งบอกได้ชัดเจนว่าไทยเป็นผู้คิดริเริ่มขึ้นมาก่อน  จากการสันนิฐาน
พบว่าเป็นการเกิดขึ้นพร้อมกัน  กล่าวคือแต่ก่อนยังไม้ได้มีเขตแดนที่ก้ันเป็นประเทศต่าง ๆ ซ่ึงแต่เดิม
จะมีการอาศัยอยู่ร่วมกันเป็นอาณาจักรหรือเป็นกลุ่มคน  ดังนั้นการเกิดขึ้นของลวดลายจึงเป็นเรื่อง
ของวัฒนธรรมของชนกลุ่มน้ัน เช่นเดียวกับเครื่องดนตรีไทยซ่ึงที่แท้จริงเป็นเคร่ืองดนตรีของกลุ่มชน
ตะวันออกเฉียงใต้  ดังจะเห็นได้ว่าเคร่ืองดนตรีมีลักษณะท่ีเป็นแบบเดียวกันหรืออาจจะมีท่วงทํานอง
แตกต่างกันไปบ้างแต่วิธีการเล่นจะคล้ายคลึงกัน  เช่นเดียวกับลวดลายที่มีความแตกต่างกันออกไป
บ้างไม่มากก็น้อยแต่มีรากฐานหรือที่มีท่ีเดียวกัน  ปัญหาสําคัญในการออกแบบลวดลายอีกอย่างก็คือ
เรื่องของขนาดท่ีพอดีกับคมสิ่ว  ซ่ึงการเลือกสิ่วแต่ละชนิดก็มีผลต่อการออกแบบลวดลายเช่นกัน  การ
วางสิ่วลงบนแบบต้องพิจารณาถึงลวดลายที่แกะสลักเป็นสําคัญหากเราต้องทําการแกะสลักควรจะต้อง
เลือกตามลวดลายหรือตามขนาดสิ่งเป็นเรื่องที่ยาก  ดังน้ีการเลือกแกะสลักตามลวดลายจึงเป็นสิ่งที่
สําคัญย่ิงเพราะหากเราเลือกแกะสลักตามสิ่วที่มีก็จะเกิดความผิดเพ้ียนหรือไม่ตรงกับลวดลายได้  แต่
สําหรับช่างแกะสลักผู้นาญก็อาจจะไม่ใส่ใจในเรื่องของลวดลายมากนัก  ซ่ึงก็ไม่ใช้ความผิดพลาดแต่
อย่างไร  การแกะสลักเป็นงานศิลปะซ่ึงมีความยืดหยุ่นได้แล้วแต่ความเหมาะสมดังน้ันการออกแบบ
ลวดลายท่ีดี  ผู้ออกแบบหรือเขียนแบบควรมีความรู้เกี่ยวกับเคร่ืองมือแกะสลักหรือขนาดของหน้าสิ่ว
ในแต่ละประเภทที่มีความแตกต่างกัน  โดยเฉพาะส่ิวต่างประเทศมีขนาดท่ีเป็นมาตราฐานและมีความ
หลากหลายเช่นหน้าโค้งครึ่งวงกลม  หรือมีปลายที่งอนออก  หรือเป็นสิ่วชนิดปาดส่วนโค้งของลาย  
จากการได้ศึกษาพบว่าสิ่วแกะสลักที่ผลิตในยุโรปมักจะมีขนาดที่เป็นมาตราฐานการผลิตท่ีเป็นงาน
เครื่องมือช่างและอุตสาหกรรม  คือใช้แม่พิมพ์แบบหล่อโลหะในการขึ้นรูปหรือหากมีการขึ้นรูปด้วย
การรีดหรือตีก็จะใช้เครื่องจักรทํา  แตกต่างกับสิ่วไทยที่เป็นงานพ้ืนบ้านกล่าวคือสิ่วส่วนใหญ่จะทําขึ้น
อย่างง่าย ๆ หรือขึ้นรูปด้วยมือโดยอาศัยความชํานาญของช่างในการตีขึ้นรูป  เราจะเห็นได้ว่าสิ่วนอก
จะมีด้ามท่ีเป็นไฟเบอร์หรือพลาสติกที่มีความเหนียวและแข็งเป็นพิเศษ  ต่างกับสิ่วไทยที่มีด้ามทําด้วย
ก่ิงไม้ท่ีช่างได้เลือกสรรค์อย่างดีท่ีมีความเหนียวแข็งแรงทนทานพอๆ กับสิ่วด้ามไฟเบอร์  อย่างไรก็ดี



76 
 

การทําสิ่วใช้เองของไทยเป็นภูมิปัญญาที่ดีและมีมาแต่โบราณ  ช่างไทยทําสิ่วขึ้นใช้เองมาตลอดซ่ึงเรา
จะเห็นได้ว่าสิ่วท่ีใช้ในการแกะสลักเป็นสิ่วท่ีดีมีคุณภาพไม่แพ้สิ่วนอก  จากการที่ตีสิ่วใช้เองก็เกิดเป็น
อาชีพช่างสิ่วเกิดขึ้นมาเพ่ือตอบสนองความต้องการ   

ผู้วิจัยได้ศึกษาและลงพ้ืนที่ในสถานท่ีทําสิ่วซ่ึงอยู่ในจังหวัดพระนครศรีอยุธยาพบว่า  การทํา
ส่ิวเป็นอุตสาหกรรมในครัวเรือนหรือทําตามมาต้ังแต่ปู ย่า ตา ยาย  การเป็นช่างที่สิ่วอาจเกิดจากการ
ทําสิ่วใช้เองซ่ึงเป็นเหตุผลหนึ่ง  แต่จากการสัมภาษณ์พบว่าการทําสิ่วท่ีอยุธยาเป็นการทําสิ่วเพ่ือขาย
เท่าน้ันไม่ได้มีจุดประสงค์จะทําขึ้นใช้เอง  เพราะการทําสิ่วขายมีรายได้ดีกว่าช่างแกะสลัก  ซ่ึงช่าง
แกะสลักจะไม่มีเวลาทําสิ่วใช้เองหรือทําเองก็ทําไม้ได้คุณภาพเท่ากับช่างทําสิ่วโดยเฉพาะ  สิ่วท่ีทําเอง
มีข้อดีท่ีมีราคาถูกกว่าสิ่วต่างประเทศหลายสิบเท่า  ซ่ึงราคาส่ิวต่างประเภทบางตัวอาจมีราคาเกินสาม
พันบาท  หากเป็นสิ่วไทยทําเองก็ราคาตัวละประมาณหน่ึงร้อยบาทเท่านั้น  สิ่วท่ีทําเองจะเป็นสิ่วที่
ผ่านการคัดเลือกชนิดของเหล็กมาอย่างดีซ่ึงช่างทําสิ่วจะมีการศึกษาทดลองใช้วัตถุดิบหลายชนิดจน
พบว่าเหล็กชนิดไหนเหมาะสม  เหล็กท่ีถูกนํามาใช้ทําสิ่วท่ีนิยมมากก็คือเหล็กแหนบรถบรรทุก หรือ
เป็นเหล็กแหนบรถไถ ซ่ึงเป็นเหล็กท่ีดีมากเพราะมีความเหนียวกว่าเหล็กชนิดอ่ืนๆ การเลือกเหล็กที่มี
ความเหนียวเป็นสิ่งท่ีต้องเลือกเป็นอันดับแรก  เพราะการใช้งานในโดยเฉพาะการแกะสลักไม้จะมีการ
งัดหรือการเซาะเน้ือไม้ซ่ึงสิ่วจะต้องมีความยืดหยุ่นหรือมีความเหนียว  เพราะถ้าหากมีแต่ความแข็งก็
จะทําให้สิ่วหักในขณะที่ทําการแกะหรืองัดได้  โดยเฉพาะสิ่วท่ีเป็นสิ่วต่างประเทศจะเป็นสิ่วท่ีทําจาก
เหล็กเหนียวท้ังสิ้น  ความเหนียวของสิ่วจึงมความจําเป็นอย่างย่ิงในการใช้งานเหล็กที่ไม่มีความเหนียว
จะเป็นเหล็กที่เปราะ  ไม่เหมาะสําหรับแกะสลักไม้  นอกจากความเหนียวของเหล็กที่จะนํามาทําเป็น
ส่ิวแล้วการตีขึ้นรูปก็มีความสําคัญมากอีกประการหน่ึง  เพราะการตีขึ้นรูปจะตีในขณะเหล็กร้อนเป็นสี
แดงเท่าน้ันเพราะการตีร้อนจะทําได้ง่ายกว่าการตีเย็น  ซ่ึงการตีเย็นจะเป็นการแต่งบางส่วนที่เป็น
เหล็กบางเท่าน้ัน  วิธีการตีสิ่วเป็นความลับเฉพาะของช่างซ่ึงอาจจะมีวิธีการตีอย่างไรให้ได้รูปทรงท่ี
พอเหมาะ  และรักษามาตราฐานของสิ่วให้ได้ในแต่ละครั้งที่ตี  สิ่วแกะสลักไม้ทําท่ีอยุธยาจะเป็นสิ่วที่
เป็นเหล็กทั้งด้ามและไม่มีส่วนที่เป็นด้ามไม้  ลักษณะของส่ิวจะเป็นเหล็กมีความยาวไม่เกิน10นิ้ว และ
มีขนาดปลายสิ่วท่ีแตกต่างกันไปแต่ตัวด้ามจะมีขนาดท่ีใกล้เคียงกันหรืออาจจะไม่มีการตีเหล็กท่ีตัว
ด้าม  การตีสิ่วแบบนี้อาจจะตีได้สะดวกแต่ก็สิ้นเปลืองวัตถุดิบหรือเหล็กมากกว่าสิ่วที่เป็นด้ามไม้  สิ่วท่ี
เป็นสิ่วนอกจะมีด้ามเป็นไม้หรือไฟเบอร์เท่าน้ัน  นอกจากสิ่วต่างประเทศแล้วสิ่วไทยที่เป็นสิ่วทําเอง
ได้แก่สิ่วเชียงใหม่ก็จะเป็นสิ่วท่ีเป็นด้ามไม้ทั้งหมด  การตีสิ่วเชียงใหม่จะมีลักษณะแตกต่างกับสิ่ว
อยุธยา  ส่วนเหล็กที่นํามาตีจะเป็นเหล็กแหนบรถยนต์เช่นเดียวกัน  อย่างไรก็ดีสิ่วทางเหนือหรือที่ช่าง
เรียกว่าสิ่วเชียงใหม่เป็นสิ่วท่ีดีและเป็นท่ีนิยมหรือช่างทางเหนือมีความถนัด  สิ่วจะประกอบด้วยตัวสิ่ว
ท่ีเป็นเหล็กเหนียวและด้ามสิ่วท่ีเป็นไม้ฝรั่ง  ซ่ึงไม้ฝรั่งจะมีความเหนียวมากกว่าไม้ชนิดอ่ืน ๆ ไม้ฝรั่งที่
นํามาทําด้ามส่ิวจะมีสองแบบคือแบบเหลาด้วยมือและแบบกลึงด้วยเครื่องกลึง  แบบเหลาด้วยมือจะมี
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ราคาถูกกว่าแบบกลึงเพราะมีความสวยงามกว่า  ไม่ว่าด้ามจะเป็นแบบใดช่างแกะสลักก็มีความ
ชํานาญในการใช้เครื่องมือแกะสลักได้เช่นเดียวกัน  ดังน้ันสิ่วที่เป็นสิ่วแกะสลักไม้ท่ีตีเองไม่ได้ทําจาก
โรงงานก็สามารถทํางานศิลปะการแกะสลักไม้มาได้ดีมาโดยตลอด  ซ่ึงความจําเป็นที่จะต้องหาซื้อสิ่ว
แพง ๆ ท่ีทําจากต่างประเทศก็ดูไม่ค่อยจะพบเห็นเท่าไรเนื่องจากหาซ้ือได้ยากแล้วก็มีราคาแพงมาก
หลายสิบเท่า  การใช้สิ่วแกะสลักไม้แบบไทยจะมีความทนทานก็ขึ้นอยู่กับผู้ใช้ด้วยว่าใช้งานในลักษณะ
ใด  หากเป็นสิ่วท่ีเป็นตัวแกะหลักก็อาจจะสึกหรอได้แต่ถ้าเป็นสิ่วที่ใช้งานในลักษณะกรีดลายหรือขุด
ต่อแต่งก็จะมีความทนทานและไม่ต้องหาซ้ือมาใช้ใหม่  อย่างไรก็ดีงานวิจัยเล่มน้ีผู้วิจัยได้ศึกษาและ
ทดลองใช้สิ่วท้ังท่ีเป็นสิ่วไทยและสิ่วต่างประเทศในการแกะสลักไม้โดยเลือกหน้าสิ่วตามแบบหรือตาม
ลาย  เพ่ือให้ได้งานตามแบบสิ่วท่ีใช้แกะสลักมีจํานวนมากมายหลายตัว  แต่เม่ือใช้งานจริงๆ แล้วอาจ
ใช้เพียง 5-10 ตัวเท่านั้นเพราะการแกะสลักมีความยืดหยุ่นเราอาจจะใช้สิ่วหน้าแคบแกะลงบน
ลวดลายท่ีมีหน้ากว้างได้  โดยต้องระมัดระวังเรื่องการวางสิ่งให้ดีหรืออย่างให้ผิดไปจากลายมากนัก สํา
การแกะสลักไม้เป็นงานศิลปะที่มีมาแต่โบราณ  ซ่ึงในปัจจุบันจะมีเครื่องแกะสลักท่ีควบคุมด้วยเครื่องร
คอมพิวเตอร์ก็ตามแต่เสนห์ของงานไม้แกะสลักเป็นสิ่งท่ีทําให้งานแกะสลักด้วยมือน้ันทรงคุณค่า
ทางด้านความงาม  และมีราคาที่สูงกว่าช้ินงานที่ทําด้วยเครื่องจักร  ถึงแม้ความก้าวหน้าทางด้าน
เทคโนโลยีในการสร้างงานแกะสลักไม้แต่การออกแบบและการเขียนลวดลายเป็นงานศิลปะท่ี
ตอบสนองความต้องการได้มาก  ถึงแม้ลวดลายแกะสลักจะออกแบบด้วยคอมพิวเตอร์ได้แต่แนวคิด
หรือทักษะในการออกแบบลวดลายจะเป็นตัวควบคุมคอมพิวเตอร์ให้เป็นไปตามความต้องการของ
ผู้ออกแบบหรือผู้เขียนแบบลวดลายแกะสลักไม้ได้เป็นอย่างดี  หากเราไม่ใช้คอมพิวเตอร์ช่วยในการ
ออกแบบก็สามารถทําได้เช่นกันแต่เราจะไม่สามารถแก้ปัญหาในการแก้ไขแบบได้  เพราะการเขียน
ด้วยคอมพิวเตอร์เป็นการช่วยให้ผู้ออกแบบมีความสะดวกสบายในการทํางาน  และให้ได้ผลงานที่มี
ความหลากหลายสามารถพลิกแพลงหรือแก้ไขลวดลายได้  โดยไม้จําเป็นต้องมีการเขียนแบบร่างหรือ
เขียนแบบขึ้นมาใหม่  โดยการเขียนลายด้วยคอมพิวเตอร์เป็นการตอบสนองหรือเป็นการพัฒนาหรือ
ยกระดับนักออกแบบลวดลายแกะสลักไม้  เพ่ือสามารถสร้างงานหรือจัดการเกี่ยวกับผลิตภัณฑ์ได้เป็น
อย่างดี  การออกแบบสมัยให้จะเป็นการพัฒนารูปแบบเดิมหรือท่ีมักเรียกกันว่าการต่อยอดทาง
ความคิด  งานแกะสลักก็เช่นกันหากสังเกตุดูตลาดงานผลิตภัณฑ์แกะสลักไม้ก็จะพบว่าผลิตภัณฑ์ส่วน
ใหญ่มักจะเป็นรูปแบบท่ีพัฒนาจากแบบเดิมหรือเป็นลายเดิม  ซ่ึงอาจเรียกได้ว่าเป็นสินค้าติดตลาดก็
ได้  อย่างไรก็ดีรูปแบบท่ีได้รับการพัฒนาจะมีความน่าสนในมากว่าและมีทางเลือกมากข้ึน ดังน้ันการ
สร้างลวดลายโดยใช้คอมพิวเตอร์ช่วยในการออกแบบบหรือเขียนแบบ  มีส่วนช่วยทําให้ผลิตภัณฑ์งาน
ไม้แกะสลักได้รับการพัฒนาเป็นผลิตภัณฑ์ที่มีคุณค่าและมีความหลากหลายมากข้ึน  ซ่ึงในบทต่อไป
ผู้วิจัยจะได้กล่าวถึงกระบวนการสร้างลวดลายแกะสลักด้วยคอมพิวเตอร์อย่างละเอียด 


